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chapter 1

About CallPilot

This chapter introduces CallPilot, the powerful multimedia messaging system
from Nortel Networks. CallPilot offers a single solution for managing many
types of information, including voice mail, fax-mail, e-mail, telephone calls,
conferencing, calendars, directories, and call logs.

CallPilot enables you to get al the information you need from one source,
whether through display-based telephone sets, your wireless set, your Windows
desktop computer, a speech recognition interface, or another personal
communications device.

In this chapter

About this quide 13
Finding your way around CallPilot 25
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Overview

Introduction

The Enterprise Networking Implementation and Administration Guide provides
the information and procedures that are necessary to implement Enterprise
Networking.

Assumptions

This guide assumes that the Meridian Application Server has been correctly
installed and is operational. If the application has not been installed, then install
it before proceeding. For installation instructions, refer to the hardware
installation guide appropriate to your server type.

If the server has been installed but is not operational, refer to the Maintenance
and Diagnostics Guide for information on troubleshooting your system.
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Skills you need

Introduction
You need certain skills and knowledge to use this guide effectively.

Nortel Networks product knowledge
Knowledge of, or experience with, the following Nortel Networks products will
assist you:
= previous releases of CallPilot
= Meridian Mall

PC experience or knowledge

Knowledge of, or experience with, the following PC products will be of
assistance. This guide does not document the following functionality:

= Microsoft Windows NT
= Microsoft Windows 95
. Microsoft Windows 2000

Other experience or knowledge

Other types of experience or knowledge that may be of use include the
following:

= switch configuration and operation (especially trunk group access
restrictions [TGARS] and network classes of service [NCOS])

= network management
= Client-server systems
= flowcharting

= troubleshooting

Enterprise Networking Implementation and Administration Guide 15
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How this guide is organized

Introduction

The Enterprise Networking Implementation and Administration Guideis
organized in the sequence of tasks required to successfully implement Enterprise
Networking for CallPilot. Start at the beginning of the guide and work your way
through it until all required tasks are completed.

Contents

This guide contains the following chapters:

Chapter title

Description

Chapter 1, About CallPilot

Chapter 2, Getting started

Chapter 3, Gathering information

Chapter 4, Configuring the switch for

Enterprise Networking

Chapter 5, Configuring CallPilot for
Enterprise Networking

This chapter describes how to work with the
CallPilot interface and how to use this guide.

This chapter provides an overview of
Enterprise Networking.

This chapter describes the features supported
by Enterprise Networking and how Enterprise
Networking works.

This chapter also provides a high-level
overview of the tasksthat are performed
during implementation.

This chapter explains how to gather the
information reguired to implement Enterprise
Networking.

This chapter explains how to configure the
switch for Enterprise Networking.

This chapter describes how to configure
CallPilot for Enterprise Networking.

This chapter describes every box that must be
completed and provides detailed procedures.

16
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Chapter title

Description

Chapter 6, Adding sites to Enterprise
Networking

Chapter 7, Testing and backing up
Enterprise Networking

Chapter 8, Maintaining Enterprise
Networking

Chapter 9, Troubleshooting Enterprise

Networking

This chapter describes how to configure the
local site. This chapter also describes how to
add and configure every sitein the messaging
network that uses Enterprise Networking to
exchange messages with local site.

This chapter describes every box that must be
completed and provides detailed procedures.

This chapter describes how to test the
implementation of Enterprise Networking to
ensure that it is properly configured. This
chapter also describes how to perform a
backup of the system.

This chapter explains how to perform both
regularly scheduled maintenance tasks and
as-required maintenance tasks.

This chapter provides information to identify
and solve problems with Enterprise
Networking.

Enterprise Networking Implementation and Administration Guide 17
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Related information products

Introduction

The following CallPilot technical documents are stored on the CD-ROM that you
receive with your system. The documents are also available from the following
SOUrces:

= CdlPilot Manager

« My CalPilot

= the Nortel Networks Partner Information Center (PIC) at
http://my.nortel networks.com

You require auser ID and a password to access the PIC. If you do not haveaPIC
account, click Register to request an account. It can take up to 72 hoursto
process your account request.

You can print part or all of aguide, asrequired.

Note: To order the documents that are available in printed format, contact your
Nortel Networks sales representative.

Planning and migration guides

Use these guides before you install CallPilot to help plan your system, or to plan a
migration of datafrom Meridian Mail to CallPilot:

Document title NTP number

Installation and Configuration Planner —
Planning and Engineering Guide 555-7101-101
What's New Guide 555-7101-901

18
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Installation and configuration guides

The following guides describe how to install the following:

» CdlPilot server hardware and software
» desktop messaging and My CallPilot software

Document title

NTP number

Desktop Messaging and My CallPilot
Installation Guide

Installation and Configuration Guide for your server
model

Thisisabinder that contains the following five
documents:

= Part 1: Installation and Maintenance Overview

s Part 2: <Server model> Server Hardware
Installation

= Part 3: <Switch name> and CallPilot Server
Configuration

= Part 4;: Software Installation and Maintenance

s Part 5: <Server model> Server Maintenance
and Diagnostics

555-7101-505

Refer to the
CallPilot
Installation and
Configuration
binder for NTP
numbers.

Administration guides

The following guides provide specialized information to help you configure

administer and maintain CalPilot, and use its features:

Document title

NTP number

Administrator’s Guide
Reporter Guide
Application Builder Guide

555-7101-301
555-7101-310
555-7101-325

Enterprise Networking Implementation and Administration Guide
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Document title NTP number

Desktop Messaging and My CallPilot Administration 555-7101-503
Guide

Meridian Mail to CallPilot Migration Utility Guide  555-7101-801

Networking guides

The following guides describe how to plan, install, set up, and troubleshoot the
CallPilot networking services:

Document title CallPilot release NTP number

Networking Enhancements Guide 2.0 555-7101-507
Networking Planning Guide 1.0 555-7101-100
NMS Implementation and 1.0 555-7101-302
Administration Guide

AMI S Networking | mplementation 1.0 555-7101-303
and Administration Guide

Enterprise Networking 1.0 555-7101-304
I mplementation and Administration

Guide

Integrated AMIS Networking 1.0 555-7101-305
I mplementation and Administration

Guide

VPIM Implementation and 1.0 555-7101-306

Administration Guide

Note: For instructions on how to configure the networking services on CallPilot,
refer to the CallPilot Manager online Help.
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End user guides

The following guides are intended for CallPilot end users, such as telephone set
users and desktop messaging users:

Document titles

Unified Messaging Quick Reference Card

Unified Messaging Wallet Card

Unified Messaging What's New Card

Command Comparison Cards

Menu Interface Quick Reference Card

Alternative Command I nterface Quick Reference Card
Multimedia Messaging User Guide

Speech Activated Messaging User Guide

Desktop Messaging User Guides

My CallPilot User Guide

Enterprise Networking Implementation and Administration Guide 21
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Troubleshooting

The CallPilot Troubleshooting Reference describes symptoms that can appear on all
CallPilot server platforms, and describes ways to resolve them.

The CallPilot Troubleshooting Reference isintended for Nortel Networks
distributors and technical support representatives; therefore, it is not part of the
customer documentation package. Nortel Networks continually updates the
CallPilot Troubleshooting Reference, which is available from the Nortel Networks
Partner Information Center (PIC) at http://my.nortelnetworks.com.

You require auser ID and a password to access the PIC. If you do not havea PIC
account, click Register to request an account. It can take up to 72 hours to process
your account request.

Note: If you are not a Nortel Networks distributor, then contact your Nortel
Networks technical support representative for assistance.

Using online sources

CallPilot administration online Help

The CallPilot Manager and CallPilot Reporter software contain administration
online Help areas that provide accessto

= technical documentation in Acrobat PDF format

= online Help topicsin HTML format

To access online information, use either of the following methods:

= Click the orange Help button at the top of any page to access the Administration
Help area.

= Click the grey Help button on any page to display atopic that relates to the
contents of the page.

For more information about using these Help systems, access the CallPilot Manager
Help, open the Getting Started book, and click “Navigating CallPilot Manager
Help.”

The Application Builder software contains a Windows Help system aswell as
context-sensitive Help (avail able by clicking the ? button and then afield or label).

22

Product Name Long



May 2003 About CallPilot

CallPilot end-user online Help
The My CallPilot software contains a Useful Information areathat provides access
to the end-user guidesin PDF format.

To access online Help for the currently selected My CallPilot tab, click the Help
button on the upper-right corner of the My CallPilot page.

Desktop messaging provides product-specific Windows Help for groupware
clients (Microsoft Outlook, Novell GroupWise, and Lotus Notes). The stand-alone
version of CallPilot Player also provides addressing and troubleshooting
information for Internet mail clients.

Contacting technical support

Contact your distributor’s technical support organization to get help with
troubleshooting your system.

Enterprise Networking Implementation and Administration Guide 23
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Conventions

Commands documented in procedures

Asin many other Windows-based applications, in CallPilot you can execute a
command in several ways. For example, to copy text you can choose any of the
following methods:

= Select Copy from the Edit menu.
= Click the Copy button on the toolbar.
= Typethekeyboard shortcut Control + C.

The procedures in this guide use only the first method: selecting a command
from amenu.

Navigation information in procedures

A Getting there statement precedes each procedure in thisguide. This
statement summarizes the steps you must take to navigate to the window or tab
where you carry out the procedure.

All Getting there statements start at the Nortel System Management

Interface (SMI) window. This assmues that you logged on and selected the
appropriate system. Eac item mentioned after the Nortel SMI window
represents an icon, window or tab that makes up the path to the final destination.

Example

To define special mailboxes, such as the broadcast mailbox, you must be on the
Mailboxes tab.

Getting there Nortel SMI > Meridian Application Server > CallPilot > Message
Administration

After you double-click Messaging Administration, the Message Administration
Properties sheet displays. Click the Mailboxes tab.
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Finding your way around CallPilot

In this section

Connecting to CallPilot 26
Multi-administrator access 34
Error handling in property sheets 36
Using the online Help 39
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Connecting to CallPilot

Introduction

To perform administrative tasks, or to build or work with CallPilot applications,
you must first connect to the Meridian Application Server (the MAS server).
The MAT Navigator and the System Management Interface (SM1) work together
to give you access to your system and sites.

Selecting a system-the MAT Navigator

Thefirst step in logging in isto launch the MAT Navigator, which hasits own
password. The MAT Navigator connects your administration client to the MAS
server. It displays all your sites and systems and enables you to select one to

work on.
H MAT Mavigator M=] E3

File Edit “iew Maintenance Configuration Secunty  Utiliiez  Window  Help

alB| #gkl = 948 e
Na'u'igatu:ur

w- (@ Downtown site

=& Uptown site
ﬁChurch B =1=11

~.[B]Main Street

kdain office

For Help. prezs F1 o
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Selecting a program—the System Management Interface (SMI)

When you select a system from the MAT Navigator, you are prompted for a
second password. At this point, the SMI window for the selected system or site

displays.

File

Wiew  Utlities ‘windows Help

L]

=]

@ @]

El Meridian Application Server
= @:I User Adminiztration

7] User Creation Templates

44 Users
ﬁ Saved Uzer Searches

E Access Classes

-z Autaddd
8] Shared Distribution Lists

£

-] System Configuration
- a
Eﬂ Alarrns & Events
{@ Systemn Performance Maonitaring
b aintenance Administration
i

0] Mailbox Classes
Systern Administration

Backup/Restore

Semvice Adrinistration

= @ CallPilat

-] Metworking

Internet bail Clients
jg Archive & Restore

-] Meszaging Administration
@ Outcalling Adminiztration

‘b Sestern Prompts Customization
S ecurnity Administration

gy Restriction Permission Lists

Enterprise Networking
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The SMI gives you quick and easy access to your system or sites. The SMI uses
anavigation treeto display the system's hierarchy. Inthetree, icons represent the
folders and programs. Double-click afolder icon to view its contents. Folders
can contain programs and other folders. Double-click a program icon to run the
associated program.

Selecting an object-list views

When you launch certain programs, the first thing you seeisalist view. Thelist
view displays all the objects of a certain type (such as mailbox classes) that are
currently defined in the system. Thelist view includes predefined objects as well
as those defined by an administrator. From the list view window, you can select
a specific object to work on.

il Mailbox Classes - Church Street - Uptown Site =] E3
File “iew Help

0] 2| x| & @k

M ame I Comments I T otal uzers in clazs
Regular Users Regular Uszers 0
Basic Lsers (0
Executive User Executive Users 1]
Agzistants Agzigtants 1]
Adriniztrator Administrator 1]
Fax Buffering Fax Buffering 1]
o | i
For Help, prezz F1 I_ Im I_ o
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Viewing and changing properties

Select an object and display its properties by

= double-clickingit or

= single-clicking it and selecting Properties from the File menu
= right-clicking it and selecting Properties from the popup menu

Entering data and choosing options-property sheets

A property sheet is displayed when you view an object selected from alist view.
Certain programs, such as Messaging Administration, display a property sheet
immediately after launching. Property sheets have one or more tabs. Each tab
has fields, referred to as boxes, in which you can type data or from which you
can select options.

Enterprise Networking Implementation and Administration Guide 29
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Most CallPilot property sheets ook like the following:

Basic Uzers - Mailbhox Claszes Properties

Mailbox | Call handing | Media | Remate Natification | RFLs |

M arme: |Ea$in: Jzers

Comment; |Easin:: zers

Storage

Woice storage limit: |':“:”:|3 :ll |minutes j
Iv Delete read meszages [voice]:  after: ||:I5 i|| dayz
v Delete read messages [fax): after: ||:|5 ill days

[ Block call answering when mailbox is full

[ Betain copy of sent messages

[v Revert DN zet by telzet

Max compozed meszage length: 0300 ﬂ Frr; 8

Max call answening meszage length: 02-00 ﬂ Frrm; 38

Language for automated zervices: |3_l,l3tem primary ﬂ
Save Canzel | Errirt | Help
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Some property sheets are divided into two panes. When abox is checked in the
left pane, the selected capabilities are enabled and you can access the associated
tabs. Select atab by clicking its namein the left pane or by clicking thetab inthe
right pane. These property sheets look like this:

Hew Uszer Properties H Ed
8 Uses General I.ﬁ.dminl Mailbm:l DMs | Set Upl Remnte nutificatiunl Saculilyl Slatusl
B & User Properties

-8 EEEE First name: |
- Admin Capability N
- 8) aadmin Iriitial(s): I
B @ Malbox Capablity Last name: I
—igd Mailbox
DHs Comments: ﬂ
Setup
Fiemole notification
Security
Status
E
Title: |
Departrment: I
| | >
Save I Cancel Print Help

Mandatory boxes

If the name of abox isunderlined, the box is mandatory, and you must fill it in.
You cannot save if any mandatory boxes are empty.
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Common buttons
The following buttons appear on most property sheets:

Button Description

Save Saves all changes made on any of the tabs in a property
sheet and closes the property sheet. Therefore, save only
when you have made the necessary changes on al tabs.

Cancel Closes the property sheet without saving any changes.
Print Prints the contents of all tabs in the property sheet.
Help Displays Help for the current tab. From this overview

Help topic, you can access other Help topics, the index,
and the search function.

Using the toolbar buttons

For easier access, some of the more common tasks, such as Print and Save, are
represented as buttons on the toolbar.

The following buttons are used throughout Call Pilot. Buttons or icons specific to
certain CallPilot functions, such as backups and archives, are documented in the
relevant chapters.

Toolbar button Description

Saves any changes you have made and then transfers
E all the application’s data to the server.

Opensthe Print dialog box and prints the active file or
% ‘ the objects you specify.

x. | Deletes the object you select.
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Toolbar button Description

Displays the properties of the object you select.

Displays the Help topics window.

Explains the next menu item or screen object you
click. In awindow, thereis an arrow. On tabsor in
dialog boxes, there is no arrow.

i

ﬂ
Opens the New dialog box, where you identify the
;I:] hﬁ properties of the object you are creating. The button
looks different in different applications.
Displays the Open dialog box, where you select an
g"‘ | H" ‘ object to open. The button is different in different

applications.

Reloads the current page and displays the changes you
have made.
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Multi-administrator access

Introduction

You can create multiple administrator accounts to make administering CallPilot
easier and more efficient. Multiple accounts enable administration
responsibilities to be distributed among a number of people. Therefore, certain
administrators can specialize in certain tasks, such as maintaining users,
performing backups, analyzing reports, or creating multimedia services.

Access classes

For security reasons, administrators should be given access only to those parts of
the system that relate to their role. For example, an administrator who is
responsible only for creating multimedia services should have access only to
Application Builder and the Service Directory Number Table.

Each administrator account is assigned an access class. An access classisalist
of the parts of the system and the level of access allowed. The access levels are

asfollows:

= create/delete (enables an administrator to delete objects such as users and
services)

»  edit

= View

= none

For example, an administrator may be able to create or delete objectsin
Application Builder but only view User Templates.
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Simultaneous access

Multiple administrators can log in to CallPilot at the same time without
overwriting other work.

If you are the first to log in to a particular resource, such as a specific mailbox
class or user profile, and another administrator tries to access the same resource,
adialog box appears to inform you of the other administrator. At this point, you
can do one of the following:

= Keep editing.
= Saveyour changes, and release the resource to the other administrator.

= Cancel your changes, and release the resource to the other administrator.

If you do not respond to this prompt within two minutes—because you are away
from the terminal, for example—the system rel eases the resource so that others
can accessiit. If this happens, all your unsaved changes are lost.

An administrator who accesses a resource that is currently being edited seesa
read-only view of the property sheet in which all boxes are dimmed. This
indicates that the resource is currently locked. The administrator is not notified
when the resource is released, but must try to access the property sheet again to
see whether its status has changed.

If auser triesto log on to a mailbox while an administrator is changing the
profile, the user is unable to log on and receives a message that says the mailbox
isinuse.

Refreshing screens

Because multiple administrators can access the same database at the same time,
aRefresh command is available from the View menu to ensure that the view you
are seeing is the most up-to-date.

For example, if you are viewing alist of users when another administrator
deletes a user, the only way to see the change is to refresh the screen. You
should, therefore, refresh the screen regularly.
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Error handling in property sheets

Introduction

If you make certain types of errors while entering data, you are not able to save
your changes until you correct the errors. For example, if you leave amandatory
box empty, you receive a message prompting you to fix it.

Note: These errors do not show up in the Event Browser or Alarm Monitor
because the errors relate only to data entry and are not operational problems.

How error handling works
There are two types of error messages.

Type 1

If you get this type of error message, click OK, and then fix the problem
described in the message before you try to save again.

36 Product Name Long



May 2003 About CallPilot

Type 2
If you get this type of error message, click OK to seealist of errors.

Uszer Creation Templates - Church Sheet - Uptown Site Eq |

& One or more errors occured during the validation of the mailbox attributes.

Double-click an error from the list. Your cursor is automatically placed in the
box where the error was made so that you can correct it.

[ Uszer Creation Templates - Church Street - Uptown Sie - Emors =]
Cloze
Error Code | Error Deszcription

MPC=10412 The Callback DM is a mandatory field and must contain 30 or fewer characters, numenc only.
MPC=10417 The target nurmber iz a mandatory field when enabled. 1t must contain 30 ar fewer characters, numeric only,

< | ]
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For example, if you double-click the second error, the Remote notification tab is
displayed, with the cursor in the Target number box.

MNew User Properties EE
fg Uzer Generall DMz I SetUp FRemote natification I Securityl Statusl 4 I ’I
Ep 8 General
B General Information
-1 & Administration ¥ RN on
i B Information : I— :

Mailbic Capabilty Target number: || Meszage type: IAH_',' PEW MEssages j
Feneral _
DMs Device type: ITeIephone j
Setup
Remate notification FIN number: I Callback number: I
Security D i
— Days active
status M Tu W Th E Sa Su
F ¥ M M ¥ O
— Time period
From [ozo0 = e fi7o0 =
I fom[7o0 = Te o =
| | o]
Save I Cancel Prrint Help
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Using the online Help

Introduction

While administering or maintaining CallPilot, you may have questions about the
purpose of certain boxes and buttons, or need more information about

compl eting certain tasks. Online Help provides brief answers to the questions
"What'sthis?' and "How do |....?"

Context-sensitive Help

If you need to know the purpose of a particular box or button, use
context-sensitive Help.
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To access context-sensitive Help
Click the | ™%= | icon in a window or the _ = Jicon on atab or in a dialog

1

box.

Point to the box or button for which you want more information, and click.

Result: A pop-up description of the selected object is displayed.

Mew User Properties

8 Usar
=W & UserProperties
General

- @ Maibox Capabilty
SR

& Mailbox

Dtz

Setup

Femate notification

4] |

Genemll fidmin  Maibos |DNS | Set Upl Femate nutificatinnl Securityl Statusl

Mailba rumber: I

Mailbos class: IHeguIar Uzer j %
Mew...

Language: I Englizhlfumerican) ﬂ

Localion na Mailbox Capabilities for users

alume [D:

Help Topics Hachk

7] %]

Ophans

Mailbox overview ﬂ

Uze the Mailbox tab to configure unigque user mailkao:

infarmation,, like the mailbox number, and to assign the user

1o amalbox class. Some of the settings, such &= the

mailbox clazs, may be prewiously set by the uzer template if

youl sre currertly crasting & new User based onthe

termplate. v ou may stil change those configured fields. You

can alzo changs the mailbox capakiities of an existing user

after accessing the LUSEr's properties. ﬂ

Save Cancel Brint Help |
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Procedures

If you need to know how to do something, you can access procedures to lead
you through atask.

High-level tasks

In some cases, high-level tasks take you through longer procedures. These tasks
also provide you with navigation to the step-by-step procedures they include.

For example, setting up Delivery to Telephone requires several procedures. The
high-level task summarizes these procedures. You click the gray buttons within
the task to open the step-by-step procedures. The high-level task remains on
your screen so that you can continue to use it to move through the procedures.

B Outcalling Administration _ O]

Help Topicz Back Options

Specifying how DTT messages are played
back

Playback of DTT messages can be customized in
tweo ways. Playback can be activated when the
recipient provides DTMF input to confirm playback
or it can be voice-activated. DTT messages can
be set to play once or twice.

recipients of DTT messages are reguired to
press a key to confirm they want to hear the
message.

to play meszages twice.

3 Click _ﬁltn continue filling in the Delivery ta
telephione takb.

| Related procedures
| Delivery to telephone overvievy infarmation
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Overview topics

Overview topics provide brief descriptions of tabs, features, and the tasks
carried out from the tabs. However, the online guides contain more detailed
feature descriptions.

To access overview topics
Click the Help button on a tab.

To find information in Help
You can look up procedures and overview topicsin the following ways:
1  From the Help menu, select Help Topics.
Note: You can also press F1 on the keyboard.
2  Go to one of the following tabs:

= To see the table of contents of all the Help topics, select the Contents
tab.

= To look up a subject alphabetically, select the Index tab.

= To do a full-text search to find topics that contain the words you enter,
select the Find tab.
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Getting started

Enterprise Networking is one of the networking solutions offered by Product
Name Long. Enterprise Networking uses a proprietary protocol, the Enterprise

Networking protocol, to exchange messages.

This chapter introduces Enterprise Networking and provides a basic overview of

the Enterprise Networking implementation process.

In this chapter

About Enterprise Networking 45
Implementing Enterprise Networking 59
How Enterprise Networking works 65
How Enterprise Networking handles messages 75
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About Enterprise Networking

In this section

Overview 46
CallPilot and Enterprise Networking 50
Names Across the Network 54

45
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Overview

Introduction

Enterprise Networking is one of the networking solutions offered by CallPilot.
This chapter introduces Enterprise Networking and provides a basic overview of
its implementation process.

You must be familiar with the basic concepts of messaging networks, dialing
plans, and protocols. To review these concepts, consult the Networ king Planning
Guide.

Definition: Enterprise Networking

Enterprise Networking is a Call Pilot networking solution that is used to transmit
messages between users at different sites in a private messaging network.

The following diagram is a conceptual illustration of how Enterprise
Networking works:
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Protocol

Enterprise Networking uses a proprietary anal og protocol that is based on
extensions to the Audio Messaging I nterchange Specification (AMIS) protocol.
Like the AMIS protocol, the Enterprise Networking protocol uses dual-tone
multifrequency (DTMF) signaling.

Since DTMF signaling is aglobal standard, Enterprise Networking can be used
globally.

Advantages of Enterprise Networking protocol
The Enterprise Networking extensions to the AMIS protocol offer important
advantages.

The Enterprise protocol requires less resource consumption and costs less to
operate.

For example, when a single message is sent to multiple recipients at the same
remote site using AM IS Networking, you make one call for each recipient. With
Enterprise Networking, you make only one call.

The Enterprise protocol also supports alonger voice message length than AMIS.

The Enterprise Networking extensions al so support additional CallPilot features
that are not supported by AMIS Networking.

Message transmitted with Enterprise Networking
A message that you transmit with Enterprise Networking consists of two parts:

= amessage header consisting of
« the mailbox numbers of the sender and the recipient or recipients
« anindication of whether the message is a regular message or a non-
delivery notification (NDN) message
» therecorded message
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Enterprise site ID numbers

Every messaging system in the messaging network is caled asite. A site
consists of aserver and one or more switches.

If you install Enterprise Networking on the messaging network, every sitein the
messaging network that exchanges messages with the site using Enterprise
Networking needs a unique site ID number.

Enterprise Networking is the only networking solution that uses site IDs.

If your implementation of Enterprise Networking is an upgrade of an existing
voice messaging system that used Enterprise Networking, maintain the site ID
numbers of the previous system.

Complex network with Enterprise Networking

You can implement Enterprise Networking on a complex messaging network
that combines several networking solutions. A messaging network is often both
open and private, combining various protocols.

The following diagram illustrates a complex network that includes sites with
Network Message Service (NMS), AMIS Networking, VPIM Networking, and
Enterprise Networking implemented.

Because Enterprise Networking is implemented in this messaging network,
every site hasaunique site ID number.

PRIVATE - MESSAGING NETWORK

Site 2
-

“VPIM ite

atellite ~ Satellite Satellite Satellite

G101139.e
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While the sites have more than one networking solution implemented, only one
protocol is used between any two sites.

Example:

Because Site 4 and Site 2 both have Integrated AMIS Networking and Enterprise
Networking implemented, you use only one protocol to send messages between

the sites. The network administrators of Site 4 and Site 2 must agree on which
protocol to use.
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CallPilot and Enterprise Networking

Introduction

Enterprise Networking supports most of the features offered by CallPilot.

Enterprise Networking features

The following table lists the CallPil ot features that are supported by Enterprise

Networking.

For detailed information about CallPil ot features, consult the Basic

Administration Guide.

CallPilot feature Supported

Notes

Call Sender Yes

Names Across the Network Yes

Name Addressing Yes

Personal Distribution Lists Yes

This feature can be used for both call
answering and composed messages from
network usersif

= thecaling lineidentification (CLID) is
present in the message, or

= the mailbox numbering plan follows the
dialing plan, or

= aremote user entry is added for the
network user

Name addressing is available if users at the
remote site are defined as remote users at
the local site. This can be done
automatically with Names Across the
Network or manually by the administrator.

Thisfeature is availableif users at the
remote site are defined as remote users at
the local site, which can be done by Names
Across the Network.
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CallPilot feature

Supported

Notes

Shared Distribution Lists

Multiple Recipients

Reply To

Reply All

User’s Actual Personal
Verification

Administrator-Recorded
Personal Verification

Remote Site Spoken
Names

Private Tag

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

A remote user isrequired. A network
address cannot be entered into the shared
distribution list unless the address
corresponds to a remote user.

The Enterprise Networking message
contains all the recipients of the message
who are a integrated sites. Recipients at
open sites are not included.

This feature can be used with al network
messages. It can also be used with call
answering messages| eft by network usersif
the calling line identification (CLID) is
present on the message and al other
conditions listed for Call Sender are met.

This feature works with al recipients at
integrated sites. It does not include
recipients at open sites.

The user’s personal verificationis played to
callersin voice messaging scenarios if
recipients are defined as remote users at the
local site. AutoAdd or Names Across the
Network can be used to create the user’s
personal verification.

The administrator can record a personal
verification for remote users who are
defined at the local site.

A spoken name can be recorded for each
remote site when configuring aremote site.

M essages tagged as private are announced
to the recipient and may not be forwarded
by the recipient to anyone else.
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CallPilot feature

Supported

Notes

Acknowledgment Tag

Urgent Tag

Economy Tag

Received Time Announced

Sent Time Announced

120-Minute Messages

Sender’s Name (Text)

Recipient’s Name (Text)

M essage Subject (Text)

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Acknowledgment tags result in amessage
to the sender indicating that the message
was actually listened to.

M essages tagged as urgent trigger urgent-
related features, such as remote notification
or message waiting indication. Urgent
messages are given priority for transmission
as determined by the scheduling
parameters.

The time when the message was deposited
into the mailbox is announced to the
recipient. The time reflects the time zone of
the recipient.

The sent time announced to the recipient
reflects the time zone of the sender, not the
recipient.

Enterprise Networking supports messages
containing up to 120 minutes of voice,
including any attachments.

This feature is supported only if American
English character set (ASCII 32-126) is
used.

If the recipients are defined as remote users,
their names are provided.

This feature is supported only if American
English character set (ASCII 32-126) is
used.

Thisfeature is supported only if American
English character set (ASCII 32-126) is
used.
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CallPilot feature Supported Notes

Sender’s Department No

Timed Delivery Yes Any message can be tagged for future
delivery.

Enterprise Networking Implementation and Administration Guide
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Names Across the Network

Names Across the Network

Names Across the Network is a feature that automatically adds temporary
remote users to alocal database and maintains them.

You can use Names Across the Network if you have Enterprise Networking
installed on your system.

Incoming and outgoing messages

You enable Names Across the Network for incoming and outgoing messages
separately. A temporary remote user can be added when

= A local user addresses a message to a user at aremote site.
= A user at aremote site addresses amessage to alocal user.

When you select Names Across the Network for incoming messages, you add
temporary remote users from all sitesin the messaging network.

However, because outgoing messages must carry additional information with
them, which results in longer transmission time, you can select Names Across
the Network for outgoing messages for individual sites. For example, you might
select the feature for outgoing messages to a site that does not incur long-
distance toll charges, but clear the feature for a site that incurs these charges.

Examples

The following examples describe a messaging network consisting of five sites.

Example 1

Asthelocal administrator of the Helsinki site, you set your system to receive
Names Across the Network by selecting the Add/Update Remote Users option.
You receive messages from all other sites that are configured to send the
information.
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However, when you configure information about the remote serversin your local
database, you clear the Send Local User Information to this Server option for the
sites to which you do not want to send remote user information. In this case, you
do not want to incur the extra long-distance toll charges associated with Names
Across the Network. Therefore, you clear the Send Local User Information to

this Server option for Cairo and Paris.

Because Lammi and Korso-Rekola are near Helsinki and do not incur long-
distance toll charges, you allow local user information to be sent to these sites.

Cairo

Paris

Local Server

Add/Update
Remote Users?

YES

Send Local User Info
to this server?

Korso-Rekola
Remote Server
Lammi

YES

Send /
Receive

Send /
Receive

1L

\ Receive

Receive

Lammi
Local charges

only

Korso-Rekola

Local charges
only

Paris

Long-distance
toll charges

Cairo

Long-distance
toll charges

G100970

However, Names Across the Network is also affected by the way the network
administrator at aremote site configures the system.
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Example 2

In this example, the network administrator in Lammi decides to clear the Send
Local User Information to this Server option when configuring the Helsinki
remote server in the local messaging database. This means that even though you
arewilling to receive Names A cross the Network from Lammi, messages are not
sent to your site in Helsinki.

Local Server

Add/Update
Remote Users?

YES

Remote Server
Lammi
Send Local User Info

to this server?

YES

Local Server

Add/Update
Remote Users?

NO

Remote Server
Helsinki
Send Local User Info
to this server?

YES

G100971

In this case, when a user from Helsinki sends a message to a user in Lammi, the
Helsinki user is not added to the Lammi database as a remote user.

To add remote users with Names Across the Network

The setting to add remote users with Names Across the Network is on the
Messaging Network Configuration page for your local server.

This setting controls your local server. You must coordinate with the system
administrator of each remote site with which you want to enable Names Across
the Network. You can use Names Acrossthe Network only with remote sites that

have Enterprise Networking installed.
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When remote users are added and updated

Names Across the Network adds atemporary remote user to the local site when
auser at the remote site sends a network message to a user at the local site. The
remote user information is taken from the header of the message that isreceived.

Limitations
Names Across the Network has the following limitations:

» Usersat remote sites are added to your system as temporary remote users
only when messages are received from them. Users at remote sites who do
not send network messages are not added to your system, even if they are
regularly name-dialed or have messages sent to them.

= Operational measurements are not collected for remote users.

» If the sender’s site does not have mailbox numbers that match the dialing
plan, the Call Sender and Name Dialing features are not available.

= Whilethe nightly audit isin progress, temporary remote users cannot be
added or updated.

=  Only 18 characters of the remote voice user’s text name are sent.

IF THEN
the first and last names are 18 the first and last names of the user are
characters or less sent.

theinitials and last name are 18 theinitials and last name of the user are
characters or less sent.

the last name only is 18 characters only the last nameis sent.

or less
the last name is longer than 18 only the last name, truncated to 18
characters characters, is sent.
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Outgoing Enterprise Networking sessions

When the local site initiates an Enterprise Networking session to aremote site,
the two sites negotiate whether spoken names are sent. This negotiation occurs
asfollows:

IF THEN

the local site chooses to send spoken = thelocal siteincludesthe sender’stext and
names and the remote site has selected the spoken name with each message.
Add/Update Remote Users on this Server

_ = the remote site adds or updates the
option

sender’s remote user information.

the local site chooses not to send spoken = thelocal site does not include the spoken
names and/or the remote site has not names for the senders.
selected the Add/Update Remote Users on

: . = the remote site does not add or update the
this Server option

sender’s remote user information.

Time stamps updated

When amessage is received from a user who already existsin the local database
as atemporary remote user, the time stamp of the remote user is updated with
the current date and time.
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Implementing Enterprise Networking

In this section
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Overview

Introduction

Planning is critical to successfully implement Enterprise Networking. Before
you begin to implement Enterprise Networking, you must understand the basic
implementation process and know what information to provide.

The process for planning the implementation of a CallPilot networking solution
is described in detail in the Networking Planning Guide. The following
overview assumes that you are familiar with this description.

Before you begin
This guide makes the following assumptions:

The switchisinstalled and configured.
Sufficient trunks that connect the switch to a public switch are available.
CallPilot isinstalled and configured, except for networking.

If implemented on the local site, Network Message Service (NMS) isfully
implemented.

If implementation is an upgrade from Meridian Mail, al legacy information
is available or is migrated.

Contact is made with the network administrators of the remote sites.

Fulfill al of these requirements before you continue with the implementation of
Enterprise Networking.

Implementation steps
To implement Enterprise Networking, you must complete the following steps:

Gather information for the network.
Configure the switch for Enterprise Networking.
Configure CallPilot for Enterprise Networking.

Add and configure the sites that use Enterprise Networking to the local
network database.

Test and back up the system.
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Gather information for the network

The first step in implementing Enterprise Networking is to gather the
information required during the configuration. You must gather information
about

= the switch configuration
»« theremote sites
You must also create a network representation.

Gather information from the switch

Much of the information you need to implement Enterprise Networking is
available in the switch database.

For example, before you begin to implement networking, the switch is set up to
make telephone callsto al the remote sites. The dialing plan existsin the switch
database. You must reflect the dialing plan settings when you configure
CdlPilot for networking.

Ask the administrator who is responsible for the switch configuration to provide
this dialing plan information.

Create the messaging network representation
You need information about the other sites in the messaging network to create a
messaging network representation.

You must create a detailed representation. This representation, which is your
blueprint for implementation, shows the relationship between all sites.

Configure the switch

The switch must be set up and configured at your site before you begin to
implement Enterprise Networking. However, you must check the configuration
and ensure that it is properly configured for Enterprise Networking.

The only additional switch configuration necessary for Enterprise Networking is
the creation and setting of phantom DNs.
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Configure CallPilot

The network database contains information about your messaging network.
When you configure CallPilot, you add information to the network database.
You must add the following information to configure CallPilot:

= genera information about the message delivery configuration

= detailed information about the local site: information about how the server
handles messages and how the switch handles messages

= detailed information about each remote site that communicates with the
local site using Enterprise Networking

Validate the configuration

When you implement Enterprise Networking, you add configuration
information about the messaging servers and switch locations to your network
database.

Before you add this information, CallPilot validates the information to ensure
that there are no conflicts.

Keep records

Asyou plan and implement Enterprise Networking, it isimportant to maintain
detailed records about your site.

These records

= provide asource of information for support personnel
» shareinformation about the site with other network administrators

Test the network

When you complete the configuration of Enterprise Networking, you perform a
test suite. Thistest suite ensures that the configuration is correct and that
Enterprise Networking isworking properly.
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Backup the network

When you successfully complete the test suite, you perform a backup. The
backup ensures that no configuration information islost in the event of system

failure.

See also
If you need additional information about the general implementation process,
consult the Networking Planning Guide.

The Networking Planning Guide provides a more detailed discussion about the
preliminary requirements, how to create network diagrams, and how to maintain
anetwork history.
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Implementation in a complex messaging
network

Introduction

Enterprise Networking is usually part of a complex messaging network that
combines several CallPilot networking solutions.

Order of implementation

If you are implementing any other CallPilot networking solutions on your site,
you will make the process easier to understand and manage by following the
correct order of implementation.

The implementation of each networking solution builds upon earlier
implementations. Information is often configured only once, and all subsequent
networking solutions that are implemented use this configuration.

Recommended order
The recommended order for implementation is

= Network Messaging Service (NMYS), if thelocal siteisan NMS site
= Integrated AMIS Networking

=  Enterprise Networking

= VPIM Networking

AMIS Networking

If your local site exchanges messages with both integrated and open sites,
implement Integrated AMIS Networking only. Integrated AMIS Networking
also contains the functionality of AMIS Networking.
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How Enterprise Networking works

In this section

About Enterprise Networking messages 66
About Enterprise Networking parameters 68
Understanding Enterprise Networking settings 72
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About Enterprise Networking messages

Introduction

You use Enterprise Networking to exchange messages among the sitesin a
messaging network. When you implement Enterprise Networking, you
configure the system to handle these messages in a particular way.

An understanding of the basic components of a message makes the
implementation process and configuration of CallPilot easier to understand.

Contents of an Enterprise Networking message
Every Enterprise Networking message contains two parts:
= amessage header
= the message body

Message header
The message header transmits to the receiving site with DTMF signals. The
header contains the following information:

» thesender’s address (which may include the site or location ID, mailbox
number, and text name, depending on how the features are enabl ed)
= eachrecipient’s address (site or location ID, mailbox number)

»« thetype of message (regular, acknowledgment, or non-delivery
notification)

= thetime and date when the message was sent

= the message priority applied to the message (private, urgent, or
acknowledgment)
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Message body

The recorded message and spoken name are played over the voice port of the
sending site and are recorded by the receiving site. The recorded message
contains the following information:

= thevoice portion of the message

= any attachments

Note: The recorded message can optionally include a spoken nameif this
feature is enabled.

Message priorities

The sender can assign a message priority to Enterprise Networking messages.
There are three message priorities:

= economy
= Standard
= Uurgent

One message priority, usually standard, isthe default. Users must assign another
message priority manually.

Configuration required for each message priority

The message priority that is assigned to a message determines how CallPilot
handles the message.

When you implement Enterprise Networking, you configure the scheduling
parameters that determine how messages with different message priority are
handled.

In general, you send economy messages during lower long-distance toll charge
periods. You send urgent messages quickly, with the emphasis on speed rather
than cost.
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About Enterprise Networking parameters

Introduction

You set Enterprise Networking parameters during the implementation process.
These parameterswork with internal CallPilot settingsto control how Enterprise
Networking works.

Before you begin the implementation process, you must understand these
parameters and decide on their settings.

Parameters set during implementation

CallPilot uses scheduling parameters to determine when to send messages to
remote sites. CallPilot uses the following scheduling parameters:

= batch threshold
= Staletimes
= economy message priority delivery start and stop times

Parameter default values

CallPilot provides default settings for all scheduling parameters. The default
values are based on typical requirements.

To ensure a quick implementation process, use these default values.

After your system is operational, monitor usage to determine if the default
settings are serving the needs of your users. You can modify the scheduling
parameters whenever users' needs change.

For al default values, see “ Defaults’ on page 124.
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Batch threshold
The batch threshold is the number of standard and urgent messages that are held
in queue waiting for delivery to asingle remote site. When you send messagesin
batches, you make more efficient use of system resources. However, to ensure
that messages awaiting delivery are not held too long in queue, the hold time
overrides the batch threshold.

A message is held in a batch until either the batch threshold is exceeded or the
hold time for standard or urgent messages is reached.

Batch thresholds only apply to standard and urgent messages.

Holding time
Holding timeisthe period of time that a message is held in queue before
CallPilot attempts delivery. CallPilot holds a message in queue while it awaits
the arrival of more messages for the same destination. This bulk sending makes
more efficient use of the system.

However, to ensure that messages are always delivered in atimely fashion and
do not wait too long for the arrival of additional messages, they are held for only
aset period of time. Thisisthe holding time.

CdllPilot computes the holding time internally, based on the stale time.

Standard message holding time
The holding time for standard messages is one-third of the stale time for
standard messages.

Urgent message holding time
The holding time for urgent messages is one-tenth of the stale time for urgent
messages.
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Stale time

Stale time determines how long an undelivered message is held within the
system before being returned to the sender with a non-delivery notification
(NDN).

Stale times are set independently for economy, standard, and urgent messages.
Typically, the stale time for an urgent message is shorter than that of a standard
message because it may be critical for auser to know that an urgent message was
not delivered.

Thefollowing examples are based on an Enterprise Networking site that usesthe
default values.

Example 1

Milo Feinstein sends a standard message. The message is held in the queue
awaiting the arrival of three more messages. However, when the message has
waited in queue for 40 minutes (the holding time for standard messages), the
message is sent.

Example 2

Ronnie Prakesh and Philippe Dumont are users at the same site. Ronnie sends
three standard messages for users at the remote site in Newmarket. Her
messages are held in the queue. Philippe sends a message to a user at the same
remote site. The batch threshold is reached, and all four messages are sent.

Example 3

Barney Gumbolski sends an urgent message. It is held in queue. No other
messages for the same remote site arrive within six minutes (the holding time for
urgent messages). Barney’s urgent message is sent.
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Economy delivery start and stop times

Economy messages receive different treament from standard and urgent
messages. Economy messages are collected and are sent only during designated
times, rather than held in queues.

The ddlivery start and stop times determine when the system sends economy
messages to their destinations.

Economy messages often have a start time set to the beginning of lower-rate
telephone services, and a stop time set to the resumption of regular rates.

Example
The following example is based on an Enterprise Networking site that uses the
current default values.

At 8:00 am., Marge Sampson sends an economy message to aremote site. The
message is held in queue until the economy delivery start time. The messageis
held in queue for atotal of 16 hours. The economy message staletimeislarge
enough to take this into account.
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Understanding Enterprise Networking settings

Introduction

In addition to the scheduling parameters, you must configure other settings when
you implement Enterprise Networking.

These settings include

= Enterprise site IDs
= initiating and responding passwords
= dialing plans

You must determining these settings in cooperation with the network
administrators of all sites. The settings must be decided on before any siteis
implemented.

Enterprise site ID

If you implement Enterprise Networking on your local site, every remote sitein
your network database requires an Enterprise site ID.

All site IDs must be unique. Therefore, you need to coordinate with remote
network administrators to ensure that this rule is observed before any siteis
implemented.

Initiating and responding passwords

Enterprise Networking uses passwords to send messages securely. When a
message is sent from one site to another, the two sites trade two passwords, an
initiating password and a responding password. Both passwords must match
before amessage is sent.

You establish passwords between pairs of sites. For this reason, you must
contact the network administrator of each remote site in the messaging network
and agree on the passwords that will be used.
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Example

The following diagram shows how passwordsin network databases must match.
Simple passwords are used for illustrative purposes.

The administrator in Bombay had to coordinate with the administratorsin Tokyo
and Tel Aviv to determine the passwords. With Tokyo, the passwords are “ 1234”
and “5678.” With Tel Aviv, the passwords are “4321” and “8765.” This
information is added to the network database in Bombay.

Bombay Network Database

Tokyo
"4321" "8765" Initiating _password: 1234
Responding password: 5678

Tel Aviv
Tokyo Initiating password: 4321
Initiating password: 1234 Responding password: 8765
Responding password: 5678 "1234" "5678" t

Tokyo Network Database
Bombay

Initiating password: 4321 Bombay

Responding password: 8765 Initiating password: 1234
Responding password: 5678

"8877" "9911" Tel Aviv
Initiating password: 8877

Responding password: 9911

Tel Aviv Network Database

G100953.eps

Selecting passwords

Like all passwords, the initiating and responding passwords should be carefully
thought out and secured. A password should be at least six characters long and
combine both al phabetic and numeric characters within the ASCI| set 3-126.
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How Enterprise Networking handles
messages

In this section

Overview 76
What the MTA does 78
What the ANA does 81
How a message is transferred 82
75
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Overview

Introduction

The scheduling parameters that you configure during the implementation of
Enterprise Networking work in conjunction with internal CallPilot networking
settings. These internal settings are controlled by

»  Message Transfer Agent (MTA)

= Anaog Networking Agent (ANA)

This brief overview provides a general understanding of how Enterprise
Networking handles messages to help you interpret Alarm and Event reports.

MTA responsibilities

The MTA isresponsible for the following services.

=  Queue outgoing network messages.

=  Determine when to begin sending messages to a remote system.
= Receive incoming messages for delivery to local users.

= Collect networking traffic operational measurements (OMs).

To ensure the timely handling of messages, the MTA wakes up CallPilot every
minute.

When it wakes up, the MTA does the following:
= initiates callsto remote sites

» checksfor stale messages

» checksif any sitesarein error status

MTA Monitor

The MTA Monitor continuously watches the performance of the MTA. The
MTA Monitor provides detailed information and is useful for regular
maintenance and troubleshooting.

For compl eteinformation about the M TA Monitor and how it isused, consult the
relevant section in System Support Tools.
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ANA responsibilities
The ANA sends messages to and from remote systems.

Thereisone ANA for every active port used during an Enterprise Networking
session.

Main steps of message transfer
There are three main steps in the message transfer process.

= TheMessage Transfer Agent determinesif the messageisready for
transfer.

= TheAnalog Networking Agent completes a communication process,
known as handshaking, with the receiving site.

=  Themessage, consisting of the message header and the message body, is
transferred.
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What the MTA does

Introduction

The Message Transfer Agent (MTA) handles most aspects of message
transmission for Product Name Long.

How MTA and ANA handle messages

The following diagram is a graphical representation of how CallPilot handles
Enterprise Networking messages.
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The diagram shows the activity of both the MTA and the ANA in message
handling.

Timer wakes up 1. Check deferred delivery messages
M TA scheduler to determine if delivery time is reached.
2. Check messages that are currently being
transported if imeout expired.
3. Send NDNs and delete stale messages.
4. Count number of urgent and standard messages.
Message queue 5. (?hecfk if messages fall within valid delivery
scanned for first time frame.
time (on per
destination basis)
Message queue
scanned for second
Next destination time - only valid
messages scanned Disabled either by
(on per destination administrator or by
basis) temporarily-suspended
transmission error
Destination
disabled?
Batch count
exceeded or YES

messages already

being
transported?
NO NO
YES
Holding time for
urgent or standard YES
messages
exceeded?
Number of
messages read
to be sent
maintained
Session or VES . )
additional sessions > ﬁzﬂ:llégllszvg
required? ul
NO
-
D E E N M M RN M M M N M M BN BN B B B N AN RN RN B BN M M M M M M M

ANA starts, calls
remote system and
delivers messages

G100969.eps
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Asthe diagram indicates, the MTA handles most of the processing. Every
minute, a scheduler wakes the MTA. The MTA scans the message queue for
each destination and checks the status of messages awaiting delivery. This scan
determinesiif there are valid messages, according to the system parameter
configuration. The MTA then determinesiif the valid messages are ready for
delivery, according to the set system parameters.

Once the MTA determines that a transmission session is needed, it seeks a
method of delivery from the call router. The ANA assumes responsibility for
delivering the message.
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What the ANA does

Introduction
The Analog Networking Agent (ANA) workswith the M TA to handle messages.

How the ANA sets up calls
The ANA calls aremote site and delivers messages.

CdllPilot originates a network call to the receiving site using the connection
directory number (DN) defined for that site. The switch placesthe call according
to switch call-processing parameters.

If the call is successful, the call terminates on the networking connection DN at
the receiving site.

If the call is not successful

If the call fails dueto abusy or no-answer condition, CallPilot waits until the
next wake-up interval before it attempts the call again. If three consecutive
attempts fail, CallPilot places the receiving site into error status and an alarmis
generated, depending on the nature of the problem.

CallPilot waits for one hour before it repeats the three-call attempt cycle.
When connection is established

When connection between the sending and receiving sites is established, ANA
initiates a communication process known as handshaking.
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How a message is transferred

Introduction

After the ANA successfully establishes a message transfer session, the message
transfer begins.

The message contains the message header and the recorded message.

How the ANA sets up calls

The ANA isresponsible for calling aremote site and delivering messages and
follows a complex routine.

CallPilot originates a network call to the receiving site using the connection
directory number (DN) defined for that site. The call is placed by the switch
according to switch call-processing parameters.

If the call is successful, the call terminates on the networking connection DN at
the receiving site.

If the call is not successful

If the call fails due to a busy or no-answer condition, CallPilot waits until the
next wake-up interval before attempting the call again. If three attemptsin arow
fail, CallPilot places the receiving site into error status and an alarmis
generated, depending on the nature of the problem.

CallPilot waits one hour before repeating the three-call attempt cycle.
When connection is established

When connection between the sending and receiving sites is established, ANA
initiates a communication process known as handshaking.

Handshaking consists of the following steps:
1. Thesending site identifiesitself to the receiving site.

2. Thereceiving site verifies that the sending site is defined in the network
database of the receiving site, and that the site ID and the message transfer
protocol agree.
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If the information does not agree, the receiving siteinformsthe sending site
of the error and drops the call.

The sending site sends the initiating password and the receiving site ID to
the receiving site.

The sending site also indicates that it will send aremote user text
information if the necessary options are enabled on the site configuration
for the receiving site.

The receiving site checks the site ID and password:

If theinformation isinvalid, the receiving site informs the sending site that
either the site ID or the password isincorrect, and drops the call.

If theinformation isvalid, the receiving site proceeds to the following step.

The receiving site determines whether remote user or message text
information will be received during this session.

The receiving site sends the responding password and indicates whether
Names Across the Network information and a text subject header will be
sent during this session.

The sending site checks the password:

If the password isinvalid, the sending site sends an end-of -session message
and drops the call.

If the password isvalid, the sending site starts the message transfer to the
receiving site.

Message transfer process

After the ANA successfully establishes a message transfer session, the message
transfer begins.

The message contains the message header and the recorded message.
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The following table describes how messages are transferred:

The sending site

The receiving site

sends the message information. The
message contains the following:

» time and date stamp
= message priority (private, urgent,
or acknowledgment)

sends the information about the
sender. The information includes the
following:

= mailbox number, including site ID
(and location ID if the remote site
isusing NMS)

if the Remote User Add/Update
option is selected, plays the spoken
name.

sends recipient information. The
information includes the following:

= mailbox number (including site
and location ID).

= recipient’s address astext, if the
Receive Text Information optionis
selected.

plays the message body.

plays any attachments.

indicates the end of the message.

receives and intercepts the message
information and creates the message.

receives and adds the sender to the
message.

= records the spoken name.
= adds or updates the remote user.

receives and adds each recipient to the
message.

records the message body and addsiit to
the message.

records each attachment and adds it to
the message.

sends to the local MTA to deposit the
message in each local recipient’s
mailbox.
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The sending site The receiving site
repeats all of the above for each repeats all of the above for each
message. message.
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Gathering information

This chapter describes how to gather the information required to implement
Enterprise Networking. This chapter provides a checklist for all information that
is needed about the switch configuration.

This chapter also describes how to gather information about the other sitesin the
messaging network, and how to convert thisinformation into a messaging
network representation.

In this chapter

Information required 89
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Information required

In this section

Overview 90
Switch information 91
Information required from the switch 93
Evaluating the gathered information 96
Information from other sites 97
Messaging network representation 98
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Overview

Introduction

Before you begin to implement Enterprise Networking, gather the information
that you require. You will speed up the implementation processif you have this
information before you begin. When you analyze the information for
inconsistencies and incompleteness, you ensure that potential problems are
resolved ahead of time.

Required information
You must gather two types of information:

local site information, especially about the switch configuration
information and dialing plan

messaging network information that is provided by all remote sites

Why gather information?
The gathered information is used to

identify the sites in the messaging network
identify how the sites relate to each other
identify the diaing plan used by each switch in the network

determine if the dialing plan on one or more switches in the network must
be modified to support the networking solutions of CallPilot

create a messaging network representation
prepare for CallPilot configuration
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Switch information

Introduction

When you begin to implement of Enterprise Networking, the switch is already
correctly installed and configured, and is operational for CallPilot.

This means that the switch is set up for dialing between the sitesin the
messaging network. The dialing plans that are configured on the switch for
making tel ephone calls between sites are also used to exchange messages
between sites.

You must check the configuration to make sureit is suitable for Enterprise
Networking.

Gathering dialing plan information

You need the dialing plan information that is configured on the switch. You must
know the dialing plan used in the messaging network and how all sitesdia each
other.

The easiest way to gather thisinformation is to ask the switch technician or
system administrator.

Gathering information directly from the switch

Gathering information directly from the switch is not recommended. The
information that you require is found on several switch configuration files called
overlays. Finding the information can be difficult and time-consuming.

If you must gather the information from the switch, consult your switch
documentation for the proper procedures and detailed descriptions of the
information in each overlay.
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Confirming settings

Usually, when the switch is configured, the switch technician addresses the
impact of messaging on the switch.

However, to ensure that there will be no problems, you must confirm that the
configuration suits the needs of Enterprise Networking and can handle your
anticipated volume of traffic.

If you discover that changes are necessary, you must compl ete these changes
before you proceed with the implementation of Enterprise Networking.
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Information required from the switch

Introduction

You must gather information from the switch. You must verify that the switch
supports networking. You use some of the information, such as dialing plan
information, to configure CallPilot.

Gather information from

= thelocal prime switch location
= theremote switch locations (prime and satellite)

Note: If thelocal siteisan NM S site, you must also gather information from
each satellite switch location. For instructions on how to gather thisinformation,
consult the NMS Implementation and Administration Guide.

Gather information about used features only

Most of the information that you gather from the switch is related to the dialing
plan.

Gather information about a dialing plan only if adialing plan is being used. Do
not gather the information if the dialing plan isinstalled on the switch but is not
currently being used.

Example: Your switch has both ESN and CDP installed. However, only ESN is
used. Do not gather CDP information.
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Local prime switch location checklist
You need the following information from the switch configuration:

name or physical location of switch (useful to name the switch location on
CallPilot)

dialing plan used:
« Electronic Switched Network (ESN)
« Coordinated Dialing Plan (CDP)
« hybrid dialing plan, combining ESN and CDP
« another dialing plan, such as public switched telephone network (PSTN)
if ESN or hybrid dialing plan is used:
« ESN access code
« ESN location codes:
- local switch location
- remote switch locations
« overlap of location codes with extension numbers
if CDP or hybrid dialing plan is used:
« CDP steering codes:
- local switch location
- remote switch location
« overlap of steering codes with extension numbers

confirmation that sufficient trunks are available for anticipated networking
traffic

confirmation that restrictions are suitable for networking (for example,
trunk group access restrictions [TGAR])

range of extension numbers used at the local site (for example, 7000—7999)

information about existing CDNs and phantom DNs that are defined on the
switch
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Remote switch location information checklist

For each remote site in the messaging network, you need the following
information about each switch location (prime and satellite):

name or physical location of switch (useful to name the switch location on
CallPilot)

dialing plan used:
« Electronic Switched Network (ESN)
« Coordinated Dialing Plan (CDP)
« hybrid dialing plan, combining ESN and CDP
« another dialing plan, such as public switched tel ephone network
if ESN or hybrid dialing plan is used:
« ESN access code
« verify the ESN location codes:
- local switch location
- remote switch locations
« overlap of location codes with extension numbers
if CDP or hybrid dialing plan is used:
« CDP steering codes:
- local switch location
- remote switch location
« overlap of steering codes with extension numbers
range of extension numbers used at the local site (for example, 7000—7999)

confirmation that all extension numbers at this switch location can be
dialed directly from the local switch

confirmation that all extension numbers at this switch location can be
dialed in the same way
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Evaluating the gathered information

Introduction

When you have the dialing plan information from all switches in the messaging
network, review the information to ensure that you do not have to make any
changes to switch configurations.

Mandatory requirement

The dialing plans of all switchesin the network must have a uniform, or
standardized, diaing plan.

A uniform dialing plan means that users on all switches dial the same way to
reach the same recipient.

Thereisonly one exception to thisrule: ESN access codes can be different.

You need auniform dialing plan to dial users on other switches within the
messaging network and at public sites.

A uniform dialing plan offers the following benefits:

= Thenetwork is easier to configure and maintain.
= Future growth of the network is allowed.

Configuring dialing plan information

You need extensive switch programming experience to configure dialing plan
information on a switch.

ATTENTION! If you determine that changes to the dialing plan
configuration are necessary, ask a switch technician to
confirm your conclusion and make the necessary changes.

See also

You can find detailed information on dialing plan configuration in your switch
documentation.
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Information from other sites

Introduction

Implementation of anetworking solution is acoordinated effort. Many decisions
must be made before implementation begins.

Gather the following information before you begin to implement Enterprise
Networking:

site names

Enterprise site IDs

fully qualified domain names (FQDNS) of servers

the protocol used between the local site and all remote sites
the dialing plan used between the local site and all remote sites

connection DNs for each site that uses the AMIS protocol to exchange
messages with the local site

If any remote sites are NM S sites, also gather the following information for each
satellite switch location:

« Switch location name
« Switchtype
« location ID

passwords—each site must decide on the initiating password and the
responding password that is used with every other site
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Messaging network representation

Introduction

A messaging network representation provides a complete summary of your
messaging network. This representation contains information about each of the
sites and indicates the relationship between each pair of sites.

If sufficiently detailed, amessaging network representation isthe primary source
of information for implementing a messaging network.

The more detail you can supply, the easier you will find the implementation
process.

A diagram is the most suitable form of representing most messaging networks.
A spreadsheet is more appropriate for large messaging networks.

Definition: Messaging network diagram

A messaging network diagram is a graphical representation of your network. It
includes the following types of information:

= dl sitesin the network

= the protocolsimplemented at each site
= theprotocol used between sites

= location codes and names

= dialing plan information

Definition: Messaging network spreadsheet

A spreadsheet is more appropriate for representing alarge messaging network. It
provides the same information as the diagram.
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Benefits

There are many benefits to creating a representation of your messaging network.
A representation

offersaclear view of how your network is connected

gathers all information required to implement a networking solution in one
source

provides useful information when you plan future modifications
helps during the analysis of traffic issues

reveals areas where you can improve the network

provides support personnel with a concise, clear view of your network

Coordinating efforts

Administrators of other sites must provide much of the information for your
network representation. For example, you need to know the site name and other
information of every site.

Although each site administrator creates a representation, ideally one site
administrator should create afinal version to distributeto all sites. This ensures
that the representation is comprehensive and that each site uses the same
information for implementation.

Protecting the representation

Your network representation contains sensitive information. Keep it properly
stored and protected as part of standard security procedures.

See also

For detailed instructions on how to create a network representation, aswell as
for several examples, consult the relevant section in the Networking Planning
Guide.
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Configuring the switch for Enterprise
Networking

This chapter describes how to configure the switch to implement Enterprise
Networking. The chapter introduces the concepts that are necessary to

understand the configuration process and provides detailed configuration
procedures.

In this chapter
Configuring the switch 103
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Configuring the switch

In this section

Overview 104
SDN Table and Enterprise Networking 106
Adding and configuring SDNs 112
Phantom DNs and Enterprise Networking 116
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Overview

Introduction
The switch provides the call handling for CallPilot.

When you implement Enterprise Networking, the switch is already installed and
configured, and is operational. It is ready for the implementation of Enterprise
Networking.

There are two steps in the configuration process. On the server, you must set up
inbound and outbound service directory numbers (SDNs) for Enterprise
Networking. On the switch, you must set up phantom directory numbers (DNs).

Before you begin

Review the information that you gathered. Confirm the settings to ensure that
they are correct.

Before you begin to implement Enterprise Networking, complete and test any
required changes to the switch settings.

How the switch views an Enterprise Networking call

The switch handles an Enterprise Networking message from the local siteto a
remote site like any other outbound telephone call.

The switch is already configured to handle outbound telephone calls. For this
reason, Enterprise Networking is just an incremental implementation.

Enterprise Networking requirements

Like all services, however, Enterprise Networking needs a route that connects
the messaging server and the switch.

Enterprise Networking requires only one additional configuration on the switch.
A phantom DN isrequired for Enterprise Networking.
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See also
For detailed information about the switch, consult your switch documentation.
For information about how CallPilot works with the switch and how the switch

must be configured, consult the relevant section in the Advanced Administration
Guide.
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SDN Table and Enterprise Networking

Definition: SDN

A service directory number (SDN) is anumber that enables a user to access a
CdlPilot service. Each SDN must be unigque so that CallPilot can identify the
requested service and play the appropriate prompts.

SDN Table

The system automatically creates the Service Directory Number Table during
theinitial installation of CallPilot. The SDN Table lists all SDNs and provides
details about their settings.

CallPilot uses the SDN Table to map directory numbers (DNs) to services. The
SDN Table lists both inbound and outbound SDNs.

Inbound and outbound SDNs

CdlPilot requires both inbound and outbound SDNs.

You must manually add an inbound SDN. An outbound SDN is created
automatically if Enterprise Networking isinstalled. Both the inbound and the
outbound SDNSs require additional configuration.

Inbound SDNs

For most services, an inbound SDN is anumber that a user enters to access a
service. However, the Enterprise Networking inbound SDN is not a directly
dialable number. A remote system diasthis SDN when it delivers an Enterprise
Networking message.

Outbound SDNs

CallPilot uses an outbound SDN to make the requested service available. An
outbound SDN consists of the word OUTBOUND and a number.
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Example: SDN Table

The following illustration shows an SDN Table that lists both inbound and

outbound Enterprise SDNs.

£ Service Directory Number - CallPilot on MAS Server - Toronto
File Edit “iew Help

2| gl X = @k

|

} Service DN |App|ication Mame | tedia Tupe | tinimum Channels | b amimum Channelz | Comments
47R0 Yoice Meszagng  Woice 0 Drefault b am,
4751 Multimedia Mezsag...Fax 0 Drefault b an.
4763 Enterprize Metwark. . Voice 1] Default b ax.
4764 AMIS Metworking  Yoice 0 Default b ax,
i

Fau ltem Maintena... Fax

2099 Multimedia Messag.. Fax
OUTBOUMDI0 AMIS Networking  Voice
QUTEQUNDTT Multimedia Mezsag... Woice
QUTEQUNDTS Multimedia Mezsag...Fax
OUTBOUMDTE Multimedia Mezsag.. Voice
QUTEQUMNDE Multimedia Mezsag... Woice
QUTEQUNDT Multimedia Mezsag... Woice
OuUTBEOUMDE Multimedia Messaq.. Fax
QUTEOUMNDA Enterprize Mebwork. Waice

Default Max. Shared with &
Default Max.
Drefault b ax.
Default bax.
Default bax.
Drefault b ax.
Default b ax.
Default bax.
Drefault b ax.
Drefault b ax.

cCcoooo oo oo

| 2]

Faor Help, presz F1

14 Items MNUM 2

If another service shares the inbound Enterprise SDN, that service appearsin the
SDN Table.

When you review an SDN Table, the only way you know if an SDN is shared is
by the description. For this reason, the description of the SDN should mention
that it is shared with the inbound Enterprise Networking SDN.
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SDN numbers

An SDN must be unique, but it is not randomly selected. CallPilot uses SDNsto
map numbers to services. There are al'so important relationships between the
SDN and other numbers used by the system.

Relationship of SDN to other numbers
The CallPilot SDN setup echoes the DN settings on the switch.

An important relationship exists between the inbound SDN and the local system
access number (SAN), and the phantom DN on the switch. For example,

=  Theinbound Enterprise Networking SDN = 7400.
=  TheEnterprise Networking local SAN = 1-416-597-7400.
= Thephantom DN for Enterprise Networking = 7400.

The Enterprise Networking inbound SDN on CallPilot must correspond to the
Enterprise Networking phantom DN on the Meridian switch. Before you create
an SDN for Enterprise Networking, confirm the phantom DN on the switch.

To view the phantom DN setting, consult the gathered switch information.

Phantom DNs

There are two ways to create an Enterprise Networking phantom DN on the
switch:

=  Define anew phantom DN for Enterprise Networking.
»  Share an existing phantom DN of specific services.

Media type

To process a call, Enterprise Networking needs access to a channel. A channel
provides a connection between the switch and the Digital Signal Processor
(DSP) cards on the CallPilot server.

CdlPilot supports three channel types. Each type corresponds to different
media:

= Voice

»  fax

= Speech recognition
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Enterprise Networking can use all three channel types. However, avoice channel
is recommended. By default, CallPilot automatically assigns a voice port to
Enterprise Networking.

Minimum and maximum channels

You must determine the channel resources for both inbound and outbound
Enterprise Networking SDNs.

Every service, including Enterprise Networking, requires channel resources to
process calls. Channel resources are the number of channels that Enterprise
Networking has available. Channel resources are set as minimum and maximum
values. The minimum value isthe number of channelsthat isalways reserved for
the exclusive use of the service.

This setting isimportant because if you incorrectly allocate channel resources,
users may experience delays in reaching requested services.

Example: Channel allocation

Your system has 96 available channels. You decide to dedicate a minimum of 5
channels and amaximum of 30 channelsto Enterprise Networking. If the system
handles only five Enterprise Networking calls each day, more appropriate
alocation isaminimum of 1 channel and maximum of 3 channels.

Examples: How to use inbound and outbound Enterprise Networking
SDNs
The following examples describe a network that consists of two sites, and show

how to use the inbound and outbound Enterprise Networking SDNs to provide
services.

In these examples, it isimportant to distinguish between messages sent by users
and calls made by the CallPilot system itself.
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Example 1: Shared SDN
This example describes how to use a shared inbound SDN.

Howard wants to send a message to Joy in Chicago. He enters 6060, which is
directed to the SDN for Integrated Voice/Fax. The request is directed to
CdlPilot, which routes it to the outbound Enterprise Networking SDN. The
system in Philadel phia calls the remote SAN of the system in Chicago,
64447080, and the two systems compl ete the required handshaking before the
message is transferred.

The Voice Menu SDN, which is shared with the inbound Enterprise Networking
SDN, receives the message. The Voice Menu SDN is set to act when it receives
an AMISinitiator tone. The message is directed to Joy’s mailbox.

MAS MAS

- Seve—. Y lkddblad,
Server = ~— B444XXXX = Server
L L]
— | 6338BXXXX —»— | -

i SDN Service v’ SDN Service
!'| 7070 Integrated Voice/Fax r — 6060 Integrate Voice/Fax
! 7075 Express Messaging 1 6070 Announcement
” 7079 Fax on Demand I 6080 Inbound Enterprise
~&|-7080 Voice menu 1
(acts on Enterprise initiator tone) <, I Qutbound Enterprise 10~
Outbound Enterprise 10
| SAN = 63386080

SAN = 64447080 |

G100993.eps
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Example 2: Unique SDN
This example describes how to use an inbound Enterprise Networking SDN that
is not shared.

Joy wants to send a message to Howard in Philadelphia. She enters 7070, which
is directed to the SDN for Integrated Voice/Fax. The request is directed to
CdlPilot, which routes it to the outbound Enterprise Networking SDN. The
system in Chicago calls the remote SAN of the system in Philadelphia,
63386080, and the two systems complete the required handshaking before the
message is transferred. The inbound Enterprise Networking SDN receives the
message and directs it to Howard's mailbox.

Server i ~— BA44XXXX EE Server
,' | E 6338x0xx — I

7079 Fax on Demand -

7080 Voice menu !
1
1

=+ » 6080 Inbound Enterprise =

(acts on Enterprise initiator tone) Outbound Enterprise 10

' " Loy ; - "Howard ]
e
1 _ !
1 ’ 1
1 ,' ,’ SDN Service SDN Service 1
1 . 1
] I4&¢ 7070 Integrated Voice/Fax 6060 Integrate Voice/Fax |
| 7075 Express Messaging 6070 Announcement 1
1
1
1
1

~ ® Outbound Enterprise 10 = = = = = = = peo ==l

| SAN = 63386080

SAN = 64447080 |

G100991.eps

See also

For detailed information on SDNs and SDN Tables, consult the Advanced
Administration Guide.
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Adding and configuring SDNs

Enterprise Networking SDNs
Enterprise Networking requires an outbound SDN and an inbound SDN.

Outbound SDN

An outbound SDN is created automatically when you install Enterprise
Networking. You can modify the default channel resource all ocation.

Inbound SDN

Aninbound SDN is not created automatically. There are two ways to set up an
inbound SDN:

Create a new inbound SDN.
Share an inbound SDN with certain other services.

The choice depends on your administrative requirements.

Do this If the primary concern is

Create new SDNs. Operational Measurement reports must be
precise for each service.

Share SDNs with other ashortage of DNs exists or is likely to exist.

services.

Services that can share an inbound SDN with Enterprise Networking
Enterprise Networking can share the inbound SDN of the following services:

Announcement Service
AMIS Networking

Fax Information Service
Voice Menu

Time of Day Controller
Thru-Diad
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Getting there Nortel SMI > Meridian Application Server > System Configuration

> Service Administration > Service Directory Number

To add and configure a new inbound SDN

1

From the SDN Table, select New from the File menu.

Result: The New Inbound Service Directory Number Properties dialog box
appears.

New Inbound Service Directory Number Properties - CallPilot on MAS___

General | Session F'n:ufilel Callback Handlingl

Service DM; I

—bpplication
Application 1D: IS
Applic:ation N ame: I Enterprise Metworking j

— Multimedia Channels and Media

Media Type: IVDiCB j

Minimum Channels: ID

M agimum Channels: ID ™ Use Default Maximum

LComrments:

-
[~

Save I Cancel | Help |

On the General tab, enter the SDN number in the Service DN box.

Note: This number must correspond to a CDN or phantom DN on the
switch.

Select an application from the Application Name list.

Result: The corresponding application ID appears above the application
name in the Application ID box.

Select the type of channel required by the service in the Media Type list.
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If you want to reserve a minimum number of channels for the service, enter
the number in the Minimum Channels box.

Do one of the following:

« Select the Use Default Maximum box. This is the recommended option.

« Enter the maximum number of channels that a service can use at one
time in the Maximum Channels box.

Note: The maximum number of channels cannot exceed the total number
of channels available on the server. If you enter a number larger than the
total number of channels, a warning box appears asking you to change the
number.

Enter any comments in the Comments box.
Click Save to add the SDN to the SDN Table.

To share an existing inbound SDN with Enterprise Networking

1

Select an existing inbound SDN that can be shared with Enterprise
Networking from the SDN Table.

On the File menu, click New.

Result: The New Inbound Service Directory Number Properties dialog box
appears.

On the General tab, in the Comments box, insert a brief comment that the
SDN is shared with Enterprise Networking.

Tip: This comment appears in the final column of the SDN Table and is the
easiest way to determine which SDN is shared with Enterprise Networking.
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4 Click the Session Profile tab.

Result: The Session Profile tab appears.

New Inbound Service Directory Number Properties - CallPilot on MAS ... [ [E3

General  Session Profile | Callback Handlingl
Session time limit: I'ID jl minutes :;ﬂmg,rg::ﬁili- I‘ID j

Mailbox number: I v

Language: I English{American) j
— Fax setting
¥ Fa selectione: Masimum pumber: |5 jl

Page limit for fax items: |4D jl

Sender fax number: I

I | Spornsor fawiters: Imipart.. | I

Biling DN: f
Fage tranzmizzion error handling: & Cartinue ) Fetransmit
Fax delivery options: IEaIIback j

Save I Cancel | Help |

5 Select Act on AMIS/Enterprise networking initiator tone. You select this
option only for the SDN that is being shared with the inbound Enterprise
SDN.

6  Click Save to add the shared SDN to the SDN Table.
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Phantom DNs and Enterprise Networking

Switch setting required for Enterprise Networking

SDNs on the server have a direct correspondence to phantom directory numbers
(DNs) on the switch.

If you create anew SDN for Enterprise Networking, you need aphantom DN for
Enterprise Networking. If you share an existing SDN for Enterprise Networking
with an existing service, Enterprise Networking also shares the phantom DN of
that service.

Enterprise Networking uses DNs

To access a CallPilot service, auser enters a unique dialable number. The
dialable number is known as a directory number (DN). There are different types
of DNs, including extension numbers and telephone numbers.

The switch uses the DN to route the call to the requested service.

Example
A user entersa DN, 7505, to access Remote Notification.

Switch and DNs

All DNsthat you use to access a service correspond to a setting on the switch. To
handle callsin sequence of arrival, the system places callsin aqueue, depending
on the cdl type.

The switch has as many as three queues, called controlled directory number
(CDN) queues, which you use for the following types of services.

= Voice Messaging
= Fax Cal Answering
= Speech Recognition Messaging

Each CDN queue is associated with a dialable number known asthe CDN. A
user can dial the service directly by entering the CDN.
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Example

The CDN of Voice Messaging is 7400. A user can dial 7400 to reach Voice
Messaging. The call is placed into the queue.

Phantom DNs

While there are queues for three types of services, Product Name Long users
usually have many individual services available within each type. These services
are also dialable.

To offer more than three services, the switch uses phantom DNSs.

A phantom DN is a unique dialable number that is routed to one of the CDN
gueues.

A phantom DN is not arandomly selected number. Thereisadirect
correspondence between the local system access number (SAN) for Enterprise
Networking and the phantom DN.

If Enterprise Networking shares an existing phantom DN, check that the
phantom DN is configured to forward messages to the correct CDN queue. For
Enterprise Networking, the phantom DN should forward messages to the Voice
Messaging CDN queue.

Example

The phantom DN for Express Messaging is 7401. A user dials 7401 and expects
to reach the requested service. However, the switch routes the phantom DN to
the appropriate CDN gueue (in this case, Voice Messaging) before the service is
provided.

Enterprise Networking phantom DN
Enterprise Networking requires a phantom DN for incoming messages.

However, unlike other phantom DN, it is not dialed by alocal user when
addressing an Enterprise Networking site. The system uses this number when an
Enterprise Networking message must be sent to aremote site.

Users at remote sites also use the phantom DN when they make acall to alocal
system.
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Ways to create the phantom DN
There are two ways to create a phantom DN for Enterprise Networking:

= Useaunique phantom DN. Most switch technicians create additional
phantom DNs for use by services like Enterprise Networking.

=  Sharean existing phantom DN. If Enterprise Networking shares a service
directory number (SDN) with another service, it also shares the phantom
DN of the service.

See also
For adetailed description of how the switch is configured for CallPilot, consult
the relevant section in the Advanced Administration Guide.
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Configuring CallPilot for Enterprise
Networking

This chapter describes how to configure CallPilot to implement Enterprise
Networking.

The chapter introduces the concepts that are necessary to understand the

configuration process and provides detailed descriptions of configuration
procedures.

In this chapter
Configuring CallPilot 121
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Configuring CallPilot

In this section

Overview 122
Configuration summary 123
Message delivery parameters—Enterprise tab 126
Configuring the message delivery parameters 129
Creating a loopback mailbox 131
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Overview

Configuring CallPilot

The implementation of Enterprise Networking requires additional configuration
of CallPilot. This configuration determines how Enterprise Networking
exchanges messages with other sites in the messaging network.

To configure CallPilot for Enterprise Networking, you must

= confirm CdlPilot administration settings
» define Enterprise Networking information
= create aloopback mailbox

ATTENTION! You must perform each step in the configuration process

in the order presented.

Before you begin
Complete the switch configuration before you configure CallPilot.
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Configuration summary

Introduction

The Enterprise Networking message delivery configuration determines how
Enterprise Networking handles messages.

You provide this information on the Enterprise tab of the Message Delivery
Configuration dialog box.

Required information
When you complete the Enterprise tab, the following are required:

See also

enabled outgoing and incoming Enterprise Networking
batch threshold

economy delivery times

stale times

A general overview of how Enterprise Networking uses thisinformation is
provided in Chapter 2, “ Getting started”.
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Standard 1.0

Defaults

CallPilot provides default settings for the message delivery configuration. The
default values are based on typical requirements.

To simplify the process of implementing Enterprise Networking, use the default
values. After your system is operational, monitor usage and performance to
determine if the default settings are sufficient. You can change the settings

whenever users' needs change.

Parameter Current default
Batch threshold 4 messages
Stale time for standard messages 2 hours

Holding time for standard messages

Stale time for urgent messages

Holding time for urgent messages

Stale time for economy messages

Delivery start time for economy
messages

Delivery stop time for economy
messages

40 minutes (calculated internally, based
on stale time settings)

60 minutes

6 minutes (calculated internally, based on
stale time setting)

6 hours

6:00 p.m.

11:00 p.m.
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Suggested process

Read through this section on how to configure Enterprise Networking
information. The settings that you select determine how efficiently your system
handles Enterprise Networking messages.

Ideally, know how you are going to complete the required information before
you begin the configuration.

Before you begin

You must properly configure the inbound and outbound SDNs for Enterprise
Networking before you configure Enterprise Networking.
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Message delivery parameters—Enterprise tab

Introduction

To implement Enterprise Networking you must set the parameters that CallPilot
uses to deliver messages.

These parameters are set on the Message Delivery Configuration dialog box
Enterprise tab.

Meszage Delivery Configuration - CallPilot on MAS Server - T [E3

AMIS 1] AMIS 2 Enterpiise | SMTP /PIM |

¥ ‘Outgaing Enterprize networking W Incoming Enterprize networking

LCaollect |1 j meszsages before zending [ Batch Threzhald |

— Economy Delivery

ime |EO000AM = imee [E0000AM =
Start Tirme: =i Stop Tirne: =i

— Stale Times

Standard: |21DD jlhh:mm Urgent: I“iDD jhh:mm
E conomy: |23155 jhh:mm

Save I Cancel | Frrint | Help

Outgoing and incoming Enterprise networking

If Enterprise Networking isinstalled on your system, the following options are
enabled by default:

= Outgoing Enterprise Networking
= Incoming Enterprise Networking
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These boxes restrict the use of Enterprise Networking.

If you do not want local users to send outbound Enterprise Networking
messages, clear the Outgoing Enterprise Networking option.

If you do not want local users to receive inbound Enterprise Networking
messages, clear the Incoming Enterprise Networking option.

To completely disable Enterprise Networking, clear both options.

Batch Threshold

When you batch messages, you send messages that are intended for asingle
destination in agroup. This method makes more efficient use of the system than
if you send each message separately.

The batch threshold defines the maximum number of messages intended for a

single destination that can be queued before CallPilot beginsto send the
messages.

The batch threshold applies only to standard and urgent message types.
The batch threshold overrides the CallPilot holding times.

Economy delivery start and stop times
An economy message is a message that a user tags for economy delivery.

Economy messages are treated differently from standard and urgent messages.
Economy messages are not held in queues. Instead, they are collected through
the day and are sent only during designated times. The delivery start and stop
times determine when the system begins to send economy messages to their
destinations.

Economy messages often have a start time set to the beginning of lower-rate
telephone services, and a stop time set to the resumption of regular rates.

Example

If the telephonerate islower between 11:00 p.m. and 6:00 a.m., set the start time
at 11:00 p.m. and the stop time a 5:55 a.m.
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Stale times

Stale time isthe period of time that CallPilot holds an undelivered message
before it considers the message undeliverable and returns it to the sender with a
non-delivery notification (NDN). In the period before a message is considered
stale, CallPilot makes repeated attempts at delivery.

Stale timeis expressed as atime period, such as 10 minutes or 5 hours.

Separate stale times are set for economy, standard, and urgent messages. The
stale time for urgent messages should be the shortest time, becauseiit is critical
to know if an urgent message is not delivered.

Stale time settings affect holding times
CallPilot uses stale time settings to calculate holding times.

The holding time is the period of time that a message is held in queue before an
attempt is made to send it.

Urgent messages
For urgent messages, the holding time is one-third of the stale time.

For example, if you set the urgent stale time to 30 minutes, the urgent message
holding time is automatically set to 10 minutes.

Standard messages
For standard messages, the holding time is one-tenth of the stale time.

For example, if you set the standard stale time to 5 hours, the standard message
holding time is automatically set to 30 minutes.

Holding times interact with the batch threshold

The interaction of the holding time and the batch threshold ensures that
messages are delivered in atimely and efficient manner. A message is sent when
the batch threshold is reached or when the holding time is reached—whichever
iS sooner.
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Configuring the message delivery parameters

Introduction
You must configure the parameters that determine how your system handles
messages.

You configure these parameters on the Message Delivery Configuration dialog
Enterprise tab.

Getting there Nortel SMI > Meridian Application Server > CallPilot > Message

Delivery Configuration > Enterprise tab

To configure Enterprise Networking parameters

1

To enable your site to send outgoing Enterprise Networking messages,
ensure the Outgoing Enterprise Networking check box is selected.

To enable your site to receive incoming Enterprise Networking messages,
ensure the Incoming Enterprise Networking check box is selected.

Enter the batch threshold in the Collect (number of) messages before
sending (Batch Threshold) box.

Enter the economy delivery start and start times in the Start Time and Stop
Time boxes.

Enter the stale times for each message type:
« Standard

« Urgent

« Economy

Click Save.

Result: The information is validated and entered into the network
database.

Enterprise Networking Implementation and Administration Guide 129



Configuring CallPilot for Enterprise Networking Standard 1.0

What's next?

After configuring CallPilot for Enterprise Networking, you must complete one
basic administrative activity. Every site in the messaging network requires a
loopback mailbox.

Although it is not mandatory to complete this administrative task at thistime, it
is recommended.

130 Product Name Long



May 2003 Configuring CallPilot for Enterprise Networking

Creating a loopback mailbox

Introduction

When you implement Enterprise Networking, create aloopback mailbox.
Although it is not mandatory to create the loopback mailbox at this time,
compl eting this task now will save you considerable time | ater.

Definition: Loopback mailbox

A loopback mailbox isamailbox that is created at each site in a messaging
network. You use aloopback mailbox to test the capability of asite.

To test that a site can send a message to a remote site, amessage is sent to the
loopback mailbox. The loopback mailbox automatically returns the message to
the sender.

Remote sites use your loopback mailbox to test their systems. You use the
loopback mailboxes of each remote site to test your system.

Since each site requires aloopback mailbox, create one now so that the testing
can proceed without interruption.

Loopback mailbox requirements

A loopback mailbox is not areal mailbox because it does not collect messages.
It bounces messages back to the sender. However, the loopback mailbox number
must be unique and cannot conflict with any other mailbox number.
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Getting there Nortel SMI > Meridian Application Server > User Administration >
Messaging Administration Properties > Mailboxes tab

To create a loopback mailbox

1 Inthe Networking Loopback mailbox box, enter the mailbox number.
2 Click Save.

Result: The information is validated and saved to the database.

Announce the loopback mailbox

Remote network administrators test their implementation by sending an
Enterprise Networking message to your loopback mailbox. Announce the
loopback mailbox number to all remote sites.

Similarly, gather the loopback mailbox numbers from the network
administrators of all other remote sites.

Using the loopback mailbox
A remote administrator addresses a test message to aloopback mailbox using
the protocol and dialing plans specified for use between the two sites.

For example, you create aloopback mailbox, 9999, on your site. Enterprise
Networking is used between aremote site and your site. The ESN dialing planis
used, and the ESN prefix to address your site from the remote site is 3555.
Therefore, to address your loopback mailbox, the remote network administrator
enters 35559999.
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Adding sites to Enterprise
Networking

This chapter describes how to define the sites in the messaging network that use
Enterprise Networking to exchange messages.

This chapter describes how to configure the local messaging server and prime
switch location. It also explains how to add and configure remote messaging
servers and switch locations.

In this chapter

About the messaging network 135
Configuring the local site 141
Adding and configuring a remote site 163
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About the messaging network

In this section

Overview 136

Configuration and other networking solutions 137
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Overview

Introduction

A CallPilot messaging network consists of alocal site and one or more remote
Sites.

All sitesin your private messaging network with which your local site
exchanges messages must appear in the Messaging Network Configuration tree
view. If aremote siteis part of the messaging network, but thelocal site does not
exchange messages with that remote site, you do not add it to the tree view.

To implement Enterprise Networking, you must configure the local site and add
and configure all remote sites that will transfer messages with the local site
using Enterprise Networking.

ATTENTION! It is strongly recommended that you complete each step

in the configuration process in the order presented.

See also

Sites are configured in the Messaging Network Configuration tree view. For an
overview of how to work with the tree view, consult the relevant section in the
Networking Planning Guide.

Before you begin

You should have already configured the Message Delivery Configuration dialog
box for Enterprise Networking.

If your local siteisan NMS site, NM S should be configured and tested.

Your messaging network representation should be complete and available. This
representation provides a blueprint for the implementation process.
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Configuration and other networking solutions

Introduction

If any other CallPilot networking solution isimplemented on your local system,
much of local messaging server and the local switch location configuration is
aready complete.

Configuring the local messaging server and switch location

If another networking solution is implemented on the local site, the local
messaging server and prime switch location configuration is almost entirely
complete. You must only confirm the settings and enter the information that is
specificaly required to implement Enterprise Networking.

For example, if Integrated AMIS Networking is aready implemented on your
system, most of the required information is already entered into the network
database.

NMS local site

If your local siteisan NMS site, implement and test NM S before you begin to
implement Enterprise Networking.

If NMSisinstalled, the NMS satellite switch locations for the local site appear
in the Messaging Network Configuration tree view below the local prime switch
location.

Remote sites

If another CallPilot networking solution isimplemented on your system, remote
sites may already be added and configured. These sites appear in the Messaging
Network Configuration tree view. These sites exchange messages with the local
site using the other networking solution.

When you implement Enterprise Networking, you must add and configure the
remote sites that will communicate with your local site using Enterprise
Networking. These sites appear in the tree view only as you add them.
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Example: Implementing Enterprise Networking

In this example, you are the network administrator of Site 6. Working with the
network administrators of the other sites in your messaging network, you have
created a diagram of your messaging network. Note that many details are
removed from this network diagram for clarity.

PRIVATE MESSAGING NETWORK
' Site 2
.

atellite ~ Satellite Satellite ~ Satellite

G101139.e

Your local site has the following networking solutions: Integrated AMIS
Networking, AMIS Networking (available because Integrated AMIS
Networking isinstalled), NMS, and Enterprise Networking.

Since you are following the recommended order of implementation, you have
completed the following for Site 6:

= NMSisimplemented and tested.

= Integrated AMIS Networking (and AMIS Networking) isimplemented and
tested.

The local messaging server and switch locations are configured.

To implement Integrated AMIS Networking, you add the following remote sites
to your network database because you use the AMIS protocol to send and
receive messages with them:

n Site 3
n Site4
. Site 5—satellite switches are also added
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You are now ready to begin implementing Enterprise Networking. After
configuring the message delivery parameters, complete the configuration of the
local messaging server and add the sites that use Enterprise Networking to the
network database.

In this example, you must add Site 1 and Site 2 to your network database,
because they are the sites that use Enterprise Networking to communicate with
your site, Site 6.
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Configuring the local site

In this section

Overview 142
Configuring the local messaging server 144
Configuring the local prime switch location 150
Configuring ESN information 156
Configuring CDP information 160
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Overview

Introduction

When Product Name Long isinitially installed on your system, alocal
messaging server and local switch location are automatically added to the
Messaging Network Configuration tree view.

Local messaging server name

By default, both the local messaging server and the prime switch location are
assigned the name “Untitled.” Assign new names to the local messaging server
and the prime switch location during configuration.

The local site receives its name from the name assigned to the local messaging
server.

Configuration

You must configure the local messaging server. To configure the messaging
server, you save general information, such as name and description, to the
network database.

The local messaging server is configured on the General tab of the Local Server
Properties dialog box.

SMTP/VPIM Server FQDN

The SMTP/VPIM Networking Server FQDN box is enabled only if VPIM
Networking isinstalled on your system. It is configured during the
implementation of VPIM Networking.

However, if the box is enabled on the General tab, you must enter a placeholder
in the box or you will be unable to close the tab and save the information to the
network database.

Whileimplementing Enterprise Networking, enter a placeholder inthisbox. You
will replace this placeholder with the correct server FQDN when you implement
VPIM Networking.
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Configuring the local server if another messaging solution is
implemented

If you have implemented another CallPilot networking solution on your local
system, you have already completed most local messaging server configuration.

For example, if Integrated AMIS Networking isalready implemented, the Name,
Description, and Send Messagesto all other Server fields are already completed.

In this case, check the current configuration and complete additional options that
are specific to Enterprise Networking and would not have been completed
during the previous implementation.
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Configuring the local messaging server

Introduction

You must configure the local messaging server to implement Enterprise
Networking.

If another networking solution is implemented, most of the information is
aready completed. You must only check the information and add the
information required for Enterprise Networking.

The local messaging server is configured on the Local Server Properties—
General tab.

Untitled - Local Server Properties E E

General |

Mame : I'—'ﬂtitIECI Server type : IEaIIF'iIu:nl "I

Ciescription : I

Send Meszages to all ather Add / Update Remote deers
W Servers r an this Server

— Enterprize Hetworking

Enterprize Site 10: I1 ill ™ Beceive Message Text Info

— SMTP / WPIM

Server EQDN:

Save I Cancel Frrint Help

144 Product Name Long



May 2003

Adding sites to Enterprise Networking

Name

By default, both the local messaging server and the prime switch location are
assigned the name “ Untitled.” Assignh new names during configuration.

The messaging server is usually given aname that corresponds to its geographic
location.

Local site name

The name given to the local messaging server becomes the name of the local
dte.

Server type

The local messaging server is always Product Name Long.

Description

Provide a brief description of the messaging server or implementation notes,
such as when the server was configured or who completed the configuration, in
the Description.

Send Messages to all other Servers

The Send Messages to all other Servers check box determinesif the local site
can send messages to integrated remote sites in the messaging network.

This check box is selected by default and is cleared only under exceptional
circumstances.

When cleared, the local messaging server does not send messages to any
integrated remote site using any protocol. Messages can still be sent to open
remote sites.

When to clear this option
This option lets you quickly disable messaging from your local site. Clear this
check box in emergency situations.

Restricting the sending of messages
Clearing the Send Messages to all other Servers check box is a quick way to
disable the system.
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You restrict the sending of messages to each remote site separately.

To prohibit the local messaging server from sending messages to a particular
remote site, clear the Send Messages to this Server check box on the Remote
Messaging Server Properties—General tab.

For example, your messaging network has six sites and you do not want to send
messages to one of these sites. You select the Send Messagesto all other Servers
option while you configure the local messaging server. You clear the Send
Messages to this Server option while you configure the remote server to which
you do not want to send messages.

Note: When the Send Messagesto all other Serversbox is cleared, users can still
send messages to open sites using the VPIM and AMI S protocols.

Add/Update Remote Users on this Server

The Names Across the Network feature is available with Enterprise Networking
only.

The Add/Update Remote Users on this Server check box enables the Names
Across the Network feature to work with Enterprise Networking.

This box controls your local server. You must coordinate with the network

administrator of each remote site with which you want to enable Names Across
the Network. You can use Names Acrossthe Network only with remote sitesthat
use Enterprise Networking and have the Send Remote User Info feature enabled.

Additional information

The Names Across the Network feature is not the only way to add remote users
to your local network database. You can aso add remote users manually with
User Administration.

For adetailed discussion of remote users and Names Across the Network,
consult the Networking Planning Guide.
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Enterprise Site ID

To implement Enterprise Networking, you must assign an Enterprise site ID to
your local messaging server.

The site ID, combined with the location ID, identifies the local site to remote
sites in the messaging network.

ThesiteID is one of the pieces of information included in a message header.

When Enterprise Networking is implemented on any site in a messaging
network, every site that exchanges Enterprise Networking messages with it must
have asite ID.

Receive Message Text Info

Thelocal messaging server can receive message subject headers in the messages
sent by all remote sites that are enabled to send message subject headers.

The message subject header is available to desktop users.

In most environments, the Receive Message Text Info check box is selected.
However, if thelocal site incurs long-distance toll charges when receiving
messages, you may want to clear this option because messages that include
message subject headers take longer to send.

Server FQDN

The Server FQDN box is enabled only if VPIM Networking isinstalled on your
local site. The server FQDN is entered when you implement VPIM Networking.

However, the Local Server Properties—General tab cannot be closed and the
information cannot be saved to the network database unless the Server FQDN
box contains some information. When you implement Enterprise Networking, if
you do not know the server FQDN, enter a placeholder in the box. If you know
the server FQDN, enter it.

For example, enter “FQDN_goes here”. A clearly marked placeholder reminds
you to compl ete the box when you implement VPIM Networking.
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Getting there Nortel SMI > Meridian Application Server > CallPilot >

Networking > Messaging Network Configuration

To configure the local messaging server

1

10

In the Messaging Network Configuration tree view, select the local
messaging server.

On the File menu, click Open.

Result: The Messaging Network Configuration—Local Server—General
tab appears.

To change the name of the local server, enter a new name in the Name box.

Tip: The name given to the local messaging server is also the name of the
local site.

Note: The server type is always CallPilot and cannot be changed.
In the Description box, enter details about the local messaging server.

To enable the local messaging server to send messages to the remote sites
in your messaging network, select the Send Messages to all other Servers
check box.

Attention: If this check box is not selected, messages cannot be sent to
remote sites. This check box is cleared only in unusual circumstances. To
clear the check box, you are prompted to confirm your decision.

To enable the Names Across the Network feature, select the Add/Update
Remote Users on this Server box.

In the Enterprise Site ID box, enter a unique ID number for the local
messaging server.

To enable the local messaging server to receive message subject headers
with Enterprise Networking messages from all remote sites that are willing
to send these headers, select the Receive Message Text Info check box.

If the Server FQDN box is enabled, enter a valid placeholder or, if available,
the FQDN of the local server.

Note: If you enter a placeholder, you replace it when you implement VPIM
Networking.

Click Save.

Result: The information is validated and saved to the network database.
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What's next?

After you configure the local messaging server, configure the local prime switch
location.
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Configuring the local prime switch location

Introduction

You must configure the local prime switch location to implement Enterprise
Networking.

If any other networking solution is implemented

If another networking solution isimplemented on the local site, the local switch
location is already configured.

Check the current configuration information. Make any necessary modifications.

If NMS is implemented

If NMSisinstalled on the local site, the local prime switch location is already
configured.

All satellite switch locations attached to the local prime switch location are also
aready configured.

Check the current configuration information. Make any necessary modifications.

If no other networking solution is installed locally

If no other networking solution isimplemented on the local site, complete the
General tab. Complete the ESN tab or the CDP tab, or both, depending on the
dialing plan used on your local switch location.
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Where the prime switch location is configured

Thelocal prime switch location is configured on the Prime Switch Location
Properties dialog box, which has four tabs:

= Generd
= ESN
= CDP

« SMTP/IVPIM

General tab
Complete the General tab no matter what dialing plan is used on your loca site.

ESN tab
Complete the ESN tab if the local site usesthe ESN or a hybrid dialing plan.

CDP tab
Complete the CDP tab if the local site usesthe CDP or a hybrid dialing plan.

SMTP/VPIM tab
The SMTP/VPIM tabis enabled only if VPIM Networking isinstaled on your
local switch location.

You complete the SMTP/VPIM tab when you implement VPIM Networking on
your local site, not during the implementation of Enterprise Networking.
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Getting there Nortel SMI > Meridian Application Server > CallPilot >
Networking > Message Delivery Configuration

To open the Prime Switch Location Properties dialog box

1 Inthe Messaging Network Configuration tree view, select the local prime
switch location.

2 On the File menu, click Open.

Result: The Messaging Network Configuration—Prime Location
Properties—General tab appears.

Local Prime Switch - Prime Location Properties

ESM | COP | SMTP /wFiM |

Marme: ILocaI Frirme Switch

Diescription; I

Enterprize Location [D: ID—j

Spoken Hame Recarded: IF Becord... | Impaort...

— Dialing and addrezzing
Dialing planz for dialing to thiz location:
¥ ESN [~ COP

¥ Mailbox addressing follows dialing plan

Mailbox prefises: I I

Save I Cancel Frrint Help
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Name
Each switch location must be assigned a name that is unique within the
messaging network. Usually, this nameis the same as the name of the messaging
server. Thisensures that the identity of the switch location within the network is
immediately apparent. A geographic name is common.
For example, if amessaging server is named “Moscow,” the prime switch
location is usually also named “Maoscow.”
By default, the local prime switch location is given the name “Untitled.” This
name must be changed.

Description

The Description box is useful for short notes, reminders, or comments about the
switch location.

You might find it useful to specify your switch model, the date of the switch
configuration, or contact information for the switch technician.

Enterprise Location ID
The Enterprise Location 1D box is not enabled for the prime switch location.

Note: Thelocation ID for a prime switch location is always 0 and cannot be
changed.

Spoken Name Recorded
If your local siteisnot an NM S site, the Spoken Name Recorded box is not
enabled.

If your siteis an NMS site, the Spoken Name Recorded check box was
configured during the NM S implementation.

Dialing plan information

Detailed information about the dialing plan used on the local prime switch
location is required when configuring the local prime switch location.
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Dialing plans for dialing to this location

You must specify which of the following dialing plansis used to dial to the local
switch location:

= ESN

= CDP

= hybrid, which combines ESN and CDP

= another dialing plan (such as PSTN)

When you configurethe local prime switch location, you specify the dialing plan
that is used to dial to the local site.

Note: If you use ESN anywhere in the messaging network, ESN must be
selected because the local site needs an ESN access code.

Mailbox specifications

The following boxes are dynamically enabled and disabled depending on the
dialing plan you have specified for the prime switch location:

= Mailbox addressing follows dialing plan
= Mailbox prefixes

Mailbox addressing follows dialing plan

The Mailbox addressing follows dialing plan box is enabled only if NMSis
installed on the local messaging server. If NM S isimplemented, this check box
should be properly configured already.

Mailbox prefixes
A mailbox prefix is aleading string of digits that uniquely identifies a mailbox
number as belonging to a particular site.

If the local site does hot have NM S installed, you never need mailbox prefixes
for thelocal prime switch location.

If the local site does have NM S installed, the mailbox prefix or prefixes should
be properly configured already.
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To configure the local prime switch location

1

To change the name of the local prime switch location, enter a name in the
Name box.

In the Description box, enter details about the local prime switch location.

In the Enterprise Location ID box, enter the location ID number of the local
prime switch location.

Note: The Enterprise location ID is always 0 and cannot be changed.
Confirm the status of the Spoken Name Recorded box.

Note: This box is enabled only if NMS is installed and was completed
during the implementation of NMS.

Specify the dialing plan used to dial the local prime switch location. Select
the

o ESN check box if ESN is used

o CDP check box if CDP is used

« ESN and CDP check boxes if a hybrid dialing plan is used

Note: Leave both check boxes clear if you use another dialing plan, such as
PSTN.

Determine whether you must complete another tab. If not, click Save to
close the dialog box.

Select another tab to continue the configuration.

What’s next?

If the local site uses an ESN, CDP, or hybrid dialing plan
After you complete the Genera tab, you must complete the ESN tab, or the CDP
tab, or both tabs, depending on the dialing plan used.

If the local site uses another dialing plan
If your local site uses another dialing plan, such as PSTN, you have completed
the configuration of your local prime switch location.

Enterprise Networking Implementation and Administration Guide 155



Adding sites to Enterprise Networking Standard 1.0

Configuring ESN information

Introduction
If thelocal prime switch location uses either an ESN dialing plan or a hybrid
dialing plan, you must complete the ESN tab.

You provide the ESN access codes and ESN location codes. These are combined
to create the ESN prefix.

Local Prime Switch - Prime Location Properties

General ESM | CDP | SMTP /vPIM |
ESM Access Code uzed by this location: I
ESM Location Codes:
| ocation Code |Dver|ap |
Add New. .. |
0= |
Save Cancel Frrint Help

See also

For adescription of the ESN dialing plan and how it works, consult the
Networking Planning Guide.
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ESN Access Code used by this location

The ESN access code is used to access ESN routing in the same way that an
access code, such as 9, isused to dia out to the public network from a private
network.

Typically, al switchesin a messaging network use the same ESN access code.

ESN Location Codes
An ESN location code is arouting prefix that identifies alocation within a
network. It isusually three digits long, but can be up to ten digits long.

You must also indicate the number of digitsin the ESN location code that
overlap the mailbox number.

The ESN Location Codeslist containsall ESN location codes currently assigned
and indicates the overlap between the ESN location code and the mailbox
directory numbers.

ESN location codes can be added, modified, or deleted at any time. The ESN
location codes must always match the dialing plan configuration on the switch.

ESN location code capacity
The maximum number of ESN location codes for a switch location is 30.

ESN location code overlap

When you enter the dialing plan information for the local site, calculate the
number of digitsin the ESN prefix that overlap the digitsin the local extension.

If there is overlap between the rightmost digit or digits of the location code and
the leftmost digit or digits of the extension number, enter the amount of overlap.

The following table provides two examples of ESN location code overlap.

Access Location Extension Number dialed by users at

code code number other sites Overlap
6 338 8300 63388300 0

6 338 8300 6338300 1
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Getting there Nortel SMI > Meridian Application Server > CallPilot >
Networking > Messaging Network Configuration > Local Prime
Switch Location > ESN tab

To configure the ESN information

1 Enter the ESN access code.
2 To add a new location code, click the Add New button.
Result: The New ESN Location Code Properties dialog box appears.

Mew ESN Location Code Properties

General |

Location Code ||
Owerlap: ID :|I

Save I Cancel | Help |

In the Location Code box, enter the location code.

4 Inthe Overlap box, enter the number of digits in the mailbox number that
overlap the location code.

5 Click Save.

Result: The location code and overlap are validated and appear in the ESN
Location Codes list box on the ESN tab.

6 Repeat steps 3-5 for each ESN location code that you require.

7  When you have finished configuring the ESN information, determine if you
must configure CDP information.
« Ifyes, click the CDP tab.

o If no, click Save to validate the ESN information and save it to the
database.
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What's next?

If your local prime switch location uses the hybrid dialing plan, click the CDP
tab to continue configuring the local prime switch location.
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Configuring CDP information

Introduction

If the local switch location uses either a CDP dialing plan or a hybrid dialing
plan, complete the CDP tab.

You must provide the CDP steering codes.

Local Prime Switch - Prime Location Properties

General| SN CDP | SMTP /PIM |

COP Steering Codes:

Steering Code | Overlap |

Add Hew...

=i

Eemave

L

Save I Cancel Print Help

See also

For ageneral description of the CDP diding plan and how it works, consult the
Networking Planning Guide.
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CDP Steering Codes

A CDP steering code is a site prefix that identifies the local site within the
network. Therefore, a CDP prefix must be unique for al switchesin the
messaging network.

CDP steering codes are determined by the switch technician.

The CDP steering codes defined on the switch are entered on CallPilot because
the system must be able to identify the steering code in the mailbox number to
determine the site.

The CDP Steering Codes list box contains all CDP steering codes currently
assigned to the switch location. The list box also indicates the overlap between
the CDP steering codes and the mailbox directory numbers.

CDP steering codes can be added, modified, or deleted.

CDP steering code capacity
The maximum number of CDP steering codes for a switch location is 500.

CDP steering code overlap

When you enter the dialing plan information, you must calcul ate the number of
digitsin the CDP steering code that overlap the digits of the local extension.

If there is overlap between the rightmost digit or digits of the steering code and
the leftmost digit or digits of the extension number, enter the amount of overlap.

Normally, the steering code overlaps with the first few digits of alocal extension
number.

The following table provides three examples of CDP steering code overlap.

Steering Extension Number dialed by users at other Amount of

code number sites overlap

22 22345 2222345 0

22 22345 222345 1

22 22345 22345 2
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Getting there Nortel SMI > Meridian Application Server > CallPilot >
Networking > Messaging Network Configuration > Local Prime
Switch Location > CDP tab

To configure the CDP information

1  Click the Add New button.
Result: The New CDP Steering Code Properties dialog box appears.

Mew CDFP 5Steering Code Properties E E

General |

Steering Code ||
Dverlap: ID :|I

Save I Cancel | Help |

2 Inthe Steering Code box, enter the steering code.

3 Inthe Overlap box, enter the number of digits in the mailbox number that
overlap the steering code.

4  Click Save.

Result: The steering code and overlap are validated and appear in the
CDP Steering Codes list box on the CDP tab.

5 Repeat steps 1-4 for each CDP steering code required.
6  When you have added all necessary CDP steering codes, click Save.

Result: The information is validated and saved to the network database.

What's next?

You have completed the configuration of the local site and are ready to begin
adding and configuring remote sites.
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Adding and configuring a remote site

In this section

Overview 164
Configuring a remote messaging server 166
Configuring a remote prime switch location 175
Configuring a remote satellite switch location 187
Recording a spoken name 191
Importing a spoken name 193
Checking the configuration of other remote sites 195
Non-CallPilot remote sites 197
Meridian Mail remote sites 199
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Overview

Introduction

When you implement Enterprise Networking, you add to the Messaging
Network Configuration tree view al the remote sites that use Enterprise
Networking to exchange messages with the local site.

Every remote site added to the tree view must be configured.

Information required

The information that you enter when you configure aremote site reflects the
information that is configured for that sitein its own local network database. For
example, you enter the name of that site and its Enterprise site ID. You must get
this information from the remote network administrator.

However, configuring aremote site involves more than simply copying the
information provided by the remote site. You also enter information that reflects
how your local site will communicate with that remote site. For example, for
each remote site, you decide whether your local site sends messages to this
particular remote server.

Main steps

There are three main steps to adding a remote site to your local network
database. For each remote site, you must add and configure

= theremote messaging server
= theremote prime switch location
= theremote satellite switch locations, if the remote siteisan NMS site

Network representation

Much of the information that you must provide while configuring aremote
messaging server is contained in the network diagram or spreadsheet.

164 Product Name Long



May 2003 Adding sites to Enterprise Networking

Correcting information about remote sites already added to the
network database

If another messaging network solution isalready implemented on your local site,
such as Integrated AMIS Networking, check the information for the remote
messaging serversthat you added to your local network database during that
configuration.

For example, when you added remote sites to your network database during the
installation of Integrated AMIS Networking, you added the remote sites that use
the AMI S protocol to send messages to and receive messages from your local
site. When configuring these remote sites, the validation process forced you to
enter an Enterprise site ID for the remote site to save the configuration to your
network database.

You must check the Enterprise site IDs that you entered for these sites to ensure
that they are valid and correct. If you entered arandom number as a placeholder,
change them to actua site ID numbers.
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Configuring a remote messaging server

Introduction

When you initially install CallPilat on your system, your local site, which
consists of alocal messaging server and alocal prime switch location, is
automatically added to the Messaging Network Configuration tree view.

However, you must manually add each remote site that exchanges messages with
the local site using Integrated AMIS Networking into the Messaging Network
Configuration tree view. You must configure both the remote messaging server
and the remote prime switch location.

You must compl ete the following tabs for each remote messaging server:

= Remote Messaging Server Properties—General tab
= Remote Messaging Server Properties—Connection Information tab

Remote servers and other messaging solutions

If you have implemented another CallPilot networking solution on your system,
you have aready added remote sites to the Messaging Network Configuration
tree view.

The process of adding aremote site is essentially the same regardless of the
networking solution being implemented. However, when you add remote sites
during the implementation of Enterprise Networking there are important
differences.
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Remote Messaging Server Properties—General tab

The Remote Messaging Server Properties—General tab contains detailed
information about the remote messaging server and defines how the local site
and the remote site exchange messages.

Mew Remote Server Properties HE

General | Cnnnectinnsl

Mame I Server type : IEaIIF'iIu:nl "I

Ciescription : I
I Send Meszages to thiz Send local uzer information
Server ta thiz Server

— Enterprize Hetworking

: ; - [ = | Send Meszage Text Info to
Enterprise Site 1D I =i (I s Carvar

— SMTP / WPIM

Server EQDN:

Save I Cancel Print Help

Name

You should assign the remote messaging server the same name that was assigned
toit by itslocal network administrator. This correspondence in haming sites
makes the network easier to administer and maintain because all network
administrators use the same names for the same sites.

For example, if aremote site callsitself “ Connecticut,” you should name it
“Connecticut” when you add it to the Messaging Network Configuration tree
view.

Enterprise Networking Implementation and Administration Guide 167



Adding sites to Enterprise Networking Standard 1.0

Server type
The remote messaging server can be any of the following types:

=  Product Name Long

= Meridian Mail Net Gateway (MMNG)
= Norstar Voice Mail (Norstar)

= Meridian Mail

= Other

Description

Provide a brief description of the remote messaging server or useful notes, such
as when the messaging server was configured or who completed the
configuration.

Send Messages to this Server

The Send Messages to this Server check box interactswith the Send Messagesto
al other Servers check box on the Local Messaging Server Properties—General
tab.

When you configured the local messaging server, you decided if you wanted the
local messaging server to send messages to all remote messaging servers. This
option isselected by default and is cleared only under exceptional circumstances
only.

However, you can till stop the delivery of messages to specific remote
messaging servers. The Send Messages to this Server check box enables you to
block the delivery of messages from your local messaging server to a particular
remote site.

168 Product Name Long



May 2003

Adding sites to Enterprise Networking

Example

In the following diagram, Helsinki is configured to deliver messages to all other
sites. However, the network database record for Paris and for Cairo specifiesthat

messages are not sent to these remote sites. M essages are sent to both Lammi

and Korso-Rekola. Therefore, while the potentia exists for sending messages to
al remote sites, only two remote sites receive messages.

Local Messaging
Server
Send
Messages
to All Other
Servers?

YES

Remote Messaging
Server
Lammi

Send messages
to this server?

Remote Messaging
Server
Korso-Rekola
Send messages
to this server?

Remote Messaging
Server
Paris
Send messages
to this server?
NO

Remote Messaging
Server
Cairo
Send messages
to this server?
NO

YES
l Send

Lammi

YES
l Send

Korso-Rekola

lDo not send

Paris

Send local user information to this Server

The Send local user information to this Server check box determinesif the
Names Across the Network feature is used with this remote site. |If enabled, this

feature was configured during the implementation of Enterprise Networking.

l Do not send

Cairo

G100995.eps
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Enterprise Site ID

The Enterprise Site ID box is enabled only if Enterprise Networking isinstalled
on thelocal site.

All remote sites connected to a site that has Enterprise Networking installed
must have an Enterprise site ID, regardless of the actual protocol used with the
dte.

Send Message Text Info to this Server

This check box applies only to remote sites that use Enterprise Networking to
exchange messages with the local site. If enabled, message text information is
sent to the remote site.

Server FQDN

If VPIM Networking isinstalled on your local site, the VPIM Networking
Server FQDN box is enabled.

However, since your local site transfers messages with this remote site using
Enterprise Networking, the Fully Qualified Domain Name (FQDN) of the
remote server is not required.
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Remote Messaging Server—Connections tab
The configuration of a remote messaging server continues on the Connections

tab.

New Remote Server Properties

General Connections |

Hetwork protocal;

— Connection DM

ong: |

DNZ: |

DN3: |

— Enterprize

Initiating Pazzword: I

Besponding Pazzword: I

Save I Cancel |

[Efime.. |
[VEfime.. |
[VEfine.. |

Frrint Help

Network protocol

When implementing Enterprise Networking, you must specify that the protocol
used by the local site to exchange messages with this remote site is Enterprise.

To use a particular protocol, both sites must have the same networking solution

installed and implemented.

If aremote siteis not configured to use the same protocol as the local site, the
following occurs when the local site attempts to send a message:

=  Themessageisnot delivered.
= Anerror message is generated.

= Theremote siteisput into error status on the local system.
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Enterprise Networking Connection DNs
When CallPilot initiates acall to aremote site, it uses the networking connection
DN that is specified for the remote site in your network database.

Up to three DNs can be defined. DN1 is mandatory. DN2 and DN3 are optional.

The first Enterprise Networking connection DN is the Enterprise Networking
SDN for the remote site, as defined in the SDN table of the remote site. If
Enterprise Networking is sharing an SDN with another service, such as AMIS
Networking, then the networking connection DN is the DN that accepts such
network calls.

You must contact the administrator of the remote site for the connection DN.
The connection is entered in aformat that is dialable from the local site.

The system always uses DN1 to call the remote site unless it encounters
problems. If the system does encounter a problem, it attempts to contact the
remote site using DN2, then DN3. In general, the DNs are ordered from least
expensive to most expensive connections. For example, DN1 could be a private
number and DN3 could be a public tel ephone number.

Network passwords

Unique passwords are used between each pair of sitesin the messaging network.
They are used to secure the messaging network and the integrity of the
messages. Two passwords are used to verify that any two sites may
communicate with each other:

= initiating password
= responding password

The passwords on your site must match the site you are calling or from which
yOu are receiving messages.
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Getting there Nortel SMI > Meridian Application Server > CallPilot >

Networking > Messaging Network Configuration

To configure a remote messaging server

1

10

11

12

In the Messaging Network Configuration tree view, select Remote Server
Maintenance.

On the File menu, click New > Messaging Server.
Result: The Remote Messaging Server Properties—General tab appears.

On the General tab, in the Name box, enter the name of the remote
messaging server.

Select the server type from the Server type box.
In the Description box, enter details about the remote messaging server.

To enable the local messaging server to send messages to this remote
messaging server, ensure that the Send Messages to this Server box is
selected.

Enter the unique Enterprise site ID number of the remote messaging server
or a valid placeholder.

To continue configuring the remote messaging server, click the
Connections tab.

Result: The Connections tab appears.

From the Network protocol list, select Enterprise.
Result: The Connection DNs boxes become enabled.
In the DN1 box, enter the connection DN.

Note: DN1 is mandatory. At least one DN must be the system access
number of the remote site.

Repeat for each connection DN.

Note: If you are defining more than one connection DN, list them in order of
cost. Connection DN1 should be the least expensive means of contacting
the remote site.

Enter the Initiating and Responding Enterprise Passwords.
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13 Click Save.

Result: The information is validated and entered into the network
database.

What's next?

After you add information about the remote messaging server into your local
network database, you must also add information about the remote prime switch
location.
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Configuring a remote prime switch location

Introduction

When you added a remote messaging server to the Message Network
Configuration tree view, a corresponding prime switch location was added.

A remote prime switch location must be configured. This processis almost
identical to configuring the local prime switch location.

Remote Prime Switch Location dialog box

The remote prime switch location is configured on the Remote Prime Switch
L ocation Properties dialog box, which has four tabs:

= Generd
= ESN
= CDP

« SMTP/IVPIM

General tab
Completing the General tab is mandatory.

ESN tab

Complete the ESN tab if an ESN or a hybrid dialing plan is used with this
remote site.

CDP tab
Complete the CDP tab if a CDP or a hybrid dialing plan is used with thisremote

site.
SMTP/VPIM tab

Because your local siteisnot using VPIM Networking to transfer messageswith
this remote site, do not complete the SMTP/VPIM tab.
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Remote Prime Switch Location Properties—General tab

Remote Site Prime Switch - Prime Location Properties

5N | COP | SMTP /WPIM |

Hame: IFlemote Site Prime Switch

Dezcription: I

Enterprize Location [0 ID ill

Spoken Hame Recorded: IND Becard... | Imnport...

r— Dialing and addrezsing
Dialing plans far dialing to this location:
[v ESN [ COP

¥ Mailbox addressing follows disling plan

Mailbow prefines: I I

Dialing prefis: I

Save I Cancel | Print Help

Name

Assign a unigue name to each switch location. The name should correspond to
the switch location to make the location easy to identify. A street or city nameis
agood choice.

The remote switch location is automatically given the name of the remote server
that was added to the Messaging Network Configuration tree view. This name
can be changed.

Description
Enter short notes or comments about the remote switch location in this box.
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Enterprise Location ID

The Enterprise Location ID box is enabled only if Enterprise Networking is
implemented on the local site.

A location ID isrequired for all remote sitesif Enterprise Networking is
installed locally, even if another protocol is used to exchange messages with this
ste.

Thelocation ID of the prime switch location is set to 0 by default and cannot be
changed.

Spoken Name Recorded
When local users compose a message to this remote site or use the playback
feature to determine the sender of a message, they hear a message that identifies
the sender. The content of the message depends on whether a spoken name for
that remote siteis recorded.

If aspoken nameis recorded, voice mail users hear the location name followed
by the local mailbox directory number.

Example: “Dallas, Mailbox 2346"

Spoken name not recorded
If aspoken name is not recorded, local users hear afull mailbox address that
does not identify the sender’s site by name.

For example, for an ESN switch location, users hear the ESN location prefix
followed by the local mailbox directory number.

Example: “Mailbox 6444 2346"

When a spoken name is not desirable

You may decide that you do not want local usersto hear a spoken name for a
particular remote site. For example, if CDP is used for messaging with this
remote site and the mailbox numbers follow the dialing plan, you may decide
that arecorded spoken name is unnecessary. In this case, do not record or import
a spoken name.

Ways to add a spoken name recording

There are two ways to add a spoken name recording: record a spoken name
directly by clicking the Record button, or import a prerecorded message.
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Dialing and addressing
Provide general information on the dialing plan used by the switch.

Several of the boxes are enabled or disabled, depending on the selections made.
The dialing plan boxes have complex interactions. Complete all enabled boxes.

Dialing plans for dialing to this location

You must specify which dialing plan is used to dial this remote switch location
from the local switch location. There are four possible dialing plans:

= ESN

« CDP

= hybrid, which combines ESN and CDP

= another (such as PSTN)

Mailbox addressing follows dialing plan
When amailbox followsthe dialing plan, auser dials and addresses amessage to
arecipient in the same way. There are two ways to achieve this correspondence:

= A user’'smailbox number and extension number are the same.

» Theaddressing plan and the dialing plan are the same.

If either situation istrue, select the Mailbox addressing follows dialing plan
check box.

Clear thisoption if users at the site do not dial and address recipientsin the same
way.
Example: If thelocal ESN prefix is 6222 and the local mailbox is 1234, remote

users can dial the local user with the number 62221234, which isthe ESN prefix
and the mailbox number combined.

Example: If the CDP steering code is 22 and the local mailbox is 1234, remote
users can dia the local user with the number 221234, which is the steering code
and the mailbox number combined.
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Mailbox prefixes
Mailbox prefixes are used by local usersto address users at aremote site if
mailboxes at the remote site do not follow the dialing plan.

A mailbox prefix must be provided if the mailbox does not follow the dialing
plan or if another dialing plan, such as PSTN, is used.

A mailbox prefix does not have to overlap with local mailbox numbers. Two
mailbox prefixes can be entered. Either prefix can be used to address any
mailbox at the local site. Normally, however, only one prefix is required.

Usually, the mailbox prefix isashortcut. A mailbox prefix can be any number as
long as it does not conflict with other network data.

A mailbox prefix can also be the entire telephone number of the site, including
country code, city/area code, and exchange.

Example: If the mailbox prefix is 22 and the mailbox number of alocal user is
6565, users at other switches address the local user by dialing 226565.

Dialing prefix
A dialing planisneeded if thelocal site uses another dialing plan, such as PSTN,
and users at your local site use adialing prefix to reach users at this remote site.

Usually, if the Dialing prefix box is enabled, you enter the prefix.

In afew cases, adialing prefix is not needed. For example, if the mailbox
number, without the mailbox prefix, can be dialed directly, adialing prefix is not
needed. This situation is rare because most systems use some sort of access
code.
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Getting there Nortel SMI > Meridian Application Server > CallPilot >

Networking > Messaging Network Configuration

To configure the remote prime switch location

1

In the Messaging Network Configuration tree view, select the remote prime
switch location.

On the File menu, select Properties.
Result: The Remote Prime Switch Location Properties dialog box appears.

On the General tab, in the Name box, enter the name of the remote prime
switch location.

In the Description box, enter details about the switch location.

Note: The Enterprise Location ID is always set to 0 for remote prime switch
locations and cannot be changed.

If needed, click Record to record a spoken name for the site, or click Import
to import a prerecorded spoken name.

Note: For instructions on how to record a spoken name, see “Recording a
spoken name” on page 191.

For instructions on how to import a spoken name, see “Importing a spoken
name” on page 193.

Specify the dialing plan used to dial the remote site. Select the
= ESN check box if ESN is used

= CDP check box if CDP is used

= ESN and CDP check boxes if a hybrid dialing plan is used

Note: Leave both check boxes clear if you use another dialing plan, such as
PSTN.

Indicate if mailbox addressing follows the dialing plan.
If necessary, enter the mailbox prefix or prefixes.

If necessary, enter the dialing prefix.
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ESN information
If the remote prime switch location uses an ESN or a hybrid dialing plan,
complete the ESN tab.

The procedure for configuring the ESN information for aremote prime switchis
identical to the procedure used for the local prime switch location.

Note: You must provide the ESN access code used at the remote site. Do not
enter the access code used localy.

For areview of the ESN access codes, ESN |ocation codes, and overlap, consult
“Configuring ESN information” on page 156.
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To configure the ESN information

1 Open Message Delivery Configuration > Remote Prime Switch Location >
ESN tab.

Remote Site Prime Switch - Prime Location Properties

General ESM | CDP | SMTP /vPIM |

ESM Access Code used by this location: ||

ESM Location Codes:

Location Code | Overlap |

Add Hew...

=i

L

Eemave

Save I Cancel | Print Help

2 Enter the ESN access code.
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3

To add a new location code, click the Add New button.
Result: The New ESN Location Code Properties dialog box appears.

Mew ESN Location Code Properties

General |

Location Code ||
Owerlap: ID :|I

Save I Cancel | Help |

In the Location Code box, enter the location code.

In the Overlap box, enter the number of digits in the mailbox number that
overlap the location code.

Click Save.

Result: The location code and overlap are validated and appear in the ESN
Location Codes box on the ESN tab.

Repeat steps 3—6 for each ESN location code required.

When you have finished configuring the ESN information, determine if you
must configure CDP information. If yes, click the CDP tab. If no, click Save.

What’s next?
If your remote prime switch location uses the hybrid dialing plan, click the CDP

tab to continue the configuration of the local prime switch location.

If the local prime switch location uses only the ESN dialing plan, click Save to

validate the configuration information and save it to the network database.
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CDP information
If aCDP dialing plan or ahybrid dialing plan is used to connect the local site to
the remote site, complete the CDP tab.

Configuring the CDP information for aremote prime switch location isidentical
to configuring the local prime switch location.

For areview of the CDP steering codes and overlap, consult “Configuring CDP
information” on page 160.
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To configure the CDP information:

1 Open Message Delivery Configuration > Remote Prime Switch Location >
CDP tab.

Remote Site Prime Switch - Prime Location Properties

Generall ESMN  CDP | SMTP /WPIM

COP Steering Codes:

Steering Code | Overlap |

Add Hew...

=i

L

Eemave

Save I Cancel Print Help

2 Click the Add New button.
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Result: The New CDP Steering Code Properties dialog box appears.

Mew CDP Steering Code Properties

General |

Steering Code : ||
Owerlap: ID :|I

Save I Cancel | Help |

In the Steering Code box, enter the steering code.

4 Inthe Overlap box, enter the number of digits in the mailbox number that
overlap the steering code.

5 Click Save.

Result: The steering code and overlap are validated and appear in the
CDP Steering Codes box on the CDP tab.

6 Repeat steps 2-5 for each CDP steering code required.
7  When you have added all necessary CDP steering codes, click Save.

Result: The information is validated and added to the network database,
and you return to the Messaging Network Configuration tree view.

What’s next?
You have completed the configuration of the remote prime switch location.
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Configuring a remote satellite switch location

Introduction

If aremote siteisan NMS site, you must add and configure each of its satellite
switch locations. Thisinformation is saved to the local network database.

Although a prime switch location is added automatically when aremote siteis
added to the M essaging Network Configuration tree view, you must manually
add each satellite switch location of aremote NMS site.

Capacity
An NMS site can have up to 59 satellite switch locations.

Organization

When you add a satellite switch location, this location appears in the M essaging
Network Configuration tree view. Satellite switch locations are listed
aphabetically below the prime switch location.

Where to configure a satellite switch location
To configure asatellite switch location, complete the General tab of the Network
Messaging Configuration property page.

You must also complete the tabs that correspond to the dialing plan used by the
local site.

ESN tab
Complete the ESN tab if you use an ESN or a hybrid dialing plan.

CDP tab
Complete the CDPtab if you use a CDP or ahybrid dialing plan.
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Spoken Name Recorded

When local users compose amessage to aremote satellite switch location or use
the playback feature to hear who sent a message, the name of the switch location
is played.

If aspoken name is not recorded, local users hear the full DN, such as*Mailbox
64441234." If arecording of the spoken name is available, local users hear the
switch location name followed by the mailbox number, such as“Milan 1234.”
You can either record a message using the telephone or import a prerecorded
WAV file.

When arecording of the spoken nameis available, Yes appears in the Spoken
Name Recorded box.

If you do not want your local usersto hear the name of this satellite switch
location when composing messages or using playback, do not record a message.
For example, if you are using CDP to transfer messages to the site and mailbox
numbers follow the dialing plan, you may feel that a spoken nameis
unnecessary.

Dialing plan interaction

The dialing plan boxes are dynamically enabled or disabled depending on the
choices made. Complete all enabled fields.

See also

Configuring a satellite switch location for aremote site is identical to
configuring aremote prime switch location for aremote site.

For areview, consult “ Configuring a remote prime switch location” on page
175.
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Getting there Nortel SMI > Meridian Application Server > CallPilot> Networking
> Messaging Network Configuration

To add a remote satellite switch location

1 Onthe Messaging Network Configuration tree view, highlight the remote
messaging server.

2 On the File menu, select New > Switch location.

Result: The Satellite Switch Location Properties dialog box appears.

Remote Site Satellite Switch - 5atellite Location Properties

[ Esn | coP | sMTF #vRIM |

Mame: IHemote Site Satellite Switch
Diescription; I

Enterprize Location [D: I‘I—j

Spoken Hame Recarded: IF Becord... | Impaort...

— Dialing and addrezzing
Dialing planz for dialing to thiz location:
¥ ESN [~ COP

¥ Mailbox addressing follows dialing plan

Mailbox prefises: I I

Dialing prefix: I

Save I Cancel | Frrint | Help |

3 To add the satellite switch location to the remote site, configure the satellite
switch location.

4 Inthe Satellite Switch Location Properties dialog box, complete the General
tab.

5 Torecord a spoken name, click Record.
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To import a prerecorded spoken name, click Import.

Note: For detailed instructions on how to record or import spoken names,
consult “Recording a spoken name” on page 191, or “Importing a spoken
name” on page 193.

6 Complete the ESN tab and the CDP tab as required.
7  Click Save.

Result: The information is validated and the satellite switch location is
added to the remote site.

8 Repeat steps 1-4 for each satellite switch location required.

When all satellite switch locations are added, click Save to save them to the
Messaging Network Configuration tree view.
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Recording a spoken name

Introduction

You can create a recording of the name of a switch location. A recorded nameis
heard by alocal user whenever an addressis played back. A recorded namefor a
siteis played if auser does not have a personal recorded name.

Local switch location
If your local siteisnot an NMS site, a spoken name is not required for the local
ste.

If your local siteisan NMS site, you can decide if you want to record a spoken
name. For example, if the NM S site uses CDP, you may decide aspoken nameis
not necessary.

Remote switch location

A spoken name should be available for every remote site in your Message
Delivery Configuration tree view.

The recording is played when local users compose messages to the remote site.

Importing a spoken name

If you do not want to record your own voice using the telephone, you can import
aprerecorded WAV file. See “Importing a spoken name” on page 193.

Before you begin

A telephone serves as the microphone. Therefore, if you want to record a spoken
name, atelephone must be available.
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Getting there Nortel SMI > Meridian Application Server > CallPilot >

Networking > Messaging Network Configuration

To record a spoken name

1

© 00 N o o

In the Messaging Network Configuration tree view, select the switch
location of the site for which you want to record a spoken name.

On the File menu, select Open.
Result: The Switch Location Properties dialog box appears.
On the General tab, click Record.

Result: The Specify Phoneset dialog box appears.

Specify Phoneset EE3

Enter a phone number;

Cancel Help

Enter the telephone number of the telephone to be used as a microphone
and click Dial.

Result: The telephone rings and the Voice Recorder dialog box appears.
Answer the telephone.

In the Voice Recorder dialog box, click Record.

Speak the name of the site into the telephone.

Click Stop.

To review the recording, click Play.

If you are satisfied with the recording, click Done.
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Importing a spoken name

Introduction

You can import a prerecorded file of the name of a switch location. The
recording is heard by alocal user whenever an address is played back. A
recording for asiteis played if a user does not have a personal spoken name.

Local switch location
If your local siteisnot an NMS site, a spoken name is not required for the local
ste.

If your local siteisan NMS site, you can decide if you want to import a spoken
name. For example, if the NM S site uses CDP, you may decide aspoken nameis
not necessary.

Remote switch location

A spoken name should be available for every remote site in your Message
Delivery Configuration tree view.

The recording is played when local users compose messages to the remote site.

Instead of importing a spoken name

If you do not want to import a prerecorded spoken name, you can record your
own voice message using the telephone.

Before you begin

A prerecorded WAV file must be available. Check the quality of the recording
before importing thefile.
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Getting there Nortel SMI > Meridian Application Server > CallPilot >

Networking > Messaging Network Configuration

To import a prerecorded file

1

4

5

In the Messaging Network Configuration tree view, select the switch
location of the site for which you want to import a prerecorded file.

On the File menu, select Open.
Result: The Switch Location Properties dialog box appears.
On the General tab, click Import.
Result: The Open dialog box appears.
Open EE
Lookjm | bin =l =N

File narme: || Open

Filez of wpe: IWAV Files [* waw] j |

Cancel

Select the WAV file, and click Open.
Result: The file is imported.

Close the Open dialog box.

194

Product Name Long



May 2003

Adding sites to Enterprise Networking

Checking the configuration of other remote

sites

Introduction

If you implemented another networking solution before you implemented
Enterprise Networking, you may not have completed al required information.

For example, if you implemented Integrated AMIS Networking, you may have
added an Enterprise site ID. You should have entered the correct site ID shown
in your network diagram. However, if you used a placeholder instead of the real
site ID, you must correct it.

Note: You are not changing the protocol used for these remote sites. You are
only defining information that Enterprise Networking uses to identify asite.

Recommended procedure

It is recommended that you check the Enterprise site ID for al remote
messaging servers added during the implementation of another networking
solution. Check the remote switch location ID number also.

To check the Enterprise Site ID

1
2
3

Open the Remote Server Properties dialog box.

On the General tab, check the Enterprise site ID.

If the site ID is correct, click Cancel.

If the site ID is incorrect, replace the ID and click Save.

Repeat steps 1-3 for each remote site added during the implementation of
another networking solution.
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To check the Enterprise Location ID

1
2
3

Open the Remote Prime Switch Location Properties dialog box.
On the General tab, check the Enterprise location ID.

If the location ID is correct, click Cancel.

If the location ID is incorrect, replace the ID and click Save.

Repeat steps 1-3 for each remote site added during the implementation of
another networking solution.
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Non-CallPilot remote sites

Introduction
Enterprise Networking can exchange messages between a CallPilot system and
the following non-CallPilot remote systems:
= a Meidian Mail (Release 8 and |ater) system
= aNorgtar Voice Mail (Release 3 and later) system

Coordination

If aremote siteis anon-CallPilot system, you must coordinate with the network
administrator of that remote site to ensure that the systems are properly
configured. You must share the standard information that is required between
any sites in amessaging network.

Example

Thetwo sites must coordinate dialing plans and ensure that there are no conflicts
in the configuration information.

Adding and configuring the remote site

Adding a non-CallPilot remote site to the local network database is exactly the
same as adding a CallPilot remote site.

To configure the non-CallPilot remote site, you require no special information.
You must only specify the server type on the Remote Messaging Server dialog
box. Therest of the configuration is the same as the configuration of a CallPilot
remote site.

Server type
Specify the server type of a non-CallPilot system on the Messaging Network
Configuration—Remote Server Properties—General tab.
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Instructions for the remote administrator
For both Meridian Mail and Norstar Voice Mail systems, there are no special
considerations that must be communicated to the remote network administrator.

You add the CallPilot site to the remote network database like any other remote
site. No specia configuration is required.
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Meridian Mail remote sites

Introduction

CallPilot can exchange Enterprise Networking messages with Meridian Mail
(Release 8 and higher).

If aremote siteisaMeridian Mail system, you must coordinate with the network
administrator of that site to ensure that the systems are properly configured.

The coordination involves standard information that is required between any
sitesin amessaging network (for example, site names and dialing plan
information).

Instructions for the remote Meridian Mail administrator
The CallPilot site is added to the network database like any other site.

Special considerations
CallPilot does not support network broadcast. If network broadcast messages are
sent from the Meridian Mail site, they are rejected.

For Meridian Mail (Release 11 and higher), the Meridian Mail administrator can
selectively disable the network broadcast for selective sites. Network broadcast
should be disabled for remote CallPilot sites.

Testing

The Meridian Mail administrator can run an additional test, the Enterprise
diagnostic test, to determine if Enterprise Networking is performing properly.
Thistest is not available for network administrators at CallPilot sites.
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Norstar Voice Mail remote sites

Introduction

Enterprise Networking can exchange messages between a Call Pilot system and a
Norstar Voice Mail (Release 3 and later) system.

Instructions for the remote Norstar Voice Mail administrator

Add the CallPilot site to the network database like any other site. There are no
special considerations that must be communicated to the network administrator.
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chapter 7

Testing and backing up Enterprise
Networking

This chapter describes how to test the Enterprise Networking configuration. The
test suite determinesif Enterprise Networking works properly both locally and
with remote sites.

This chapter also describes how to create a backup of your system to ensure that
the correct configuration is not lost due to system failure.

In this chapter
Tests and backups 203
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Tests and backups

In this section

Enterprise Networking test suite 204
Call routing test 206
Local SDN test 207
Quick SDN test 209
Loopback test 210
End-to-end test 212
Backing up Enterprise Networking 215
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Enterprise Networking test suite

Introduction

After you configure Product Name Long for Enterprise Networking, test the
system.

The Enterprise Networking test suite tests every aspect of the system. If any test
fails, resolve the problem and retry the test before you continue.

Note: These tests are not intended to validate the Enterprise compliance of a
third-party system. The tests assume that any system that you communicate with
is Enterprise-compliant.

Test suite

The Enterprise Networking test suite consists of five tests. Two tests are local
site tests, which verify that your local configuration is correct. Three tests are
coordinated site tests, which verify that everything works properly at your site
and at every remote site.

The following table lists the local site tests and describes their purpose:

This local site test determines if

call routing test = thelocal system can make outbound
calls to other sitesin the network.

= thelocal system cannot make
outbound callsto restricted siteson the
network.

local SDNstest = Digital Signal Processing (DSP) cards
are working properly and SDNs are
defined correctly.

204

Product Name Long



May 2003 Testing and backing up Enterprise Networking

The following table lists the coordinated site tests and describes their purpose:

This coordinated site test determines if

end-to-end test = aremote system can receive messages
from the local system.

loopback test = thelocal system can receive messages
from the remote system.

Coordination

While you can perform local site tests independently, you must work with the
network administrators at each remote site to perform the coordinated site tests.

In some instances, the remote administrator must make preparations before you
can conduct the test. For example, to complete the loopback test, the remote
network administrator must create aloopback mailbox.

If atest is unsuccessful and you do not find the cause of the problem locally,
work with the remote administrators to determine the cause of the problem.

For quick results

When you test your implementation of Enterprise Networking, there are two
ways to ensure quick results:

= Change the batch threshold to 1.
= Tag atest message as an urgent priority message.

An urgent tag ensures quick results. You do not need to change the scheduling
parametersto perform the tests and return them to their original settings after
you complete the tests.

Note: Messages tagged as urgent are handled according to the scheduling
parameters. For example, if the urgent message hold time is five minutes, it may
take five minutes before the test message is sent.
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Call routing test

Introduction
The call routing test determinesif the local system
= can make outbound calls to other sites using Enterprise Networking

= cannot make outbound calls to numbersthat are configured as restricted on
the system

Before you begin

Ask the switch technician for the ACD/UCD agent and trunk printouts for the
switch.

To perform the call routing test

1 Use the ACD/UCD agent and trunk printouts to select an ACD/UCD agent.
2 Program a telephone to use the same NCOS and TGAR as the agent.
Note: For instructions, consult your switch documentation.
Dial a network address.
4  Repeat steps 1-3 for a number that you know should be restricted.

Example: Attempt to access a trunk directly.

Evaluating test results

Thecall routing test is successful if an outbound call goes through to the allowed
system but is blocked to arestricted system.

If the test is not successful

If the call routing test fails or produces unexpected results, a switch technician
must check the switch settings that control routing and restrictions on calls.

What’s next?
After you successfully complete the call routing test, perform the local SDN test.
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Local SDN test

Introduction

Thelocal SDN test verifiesthat the local system can receive messages from a
remote system. Thistest confirmsthat the SDN for Enterprise Networking in the
SDN Tableis correct.

The quick SDN test can be substituted for the local SDN test. See “ Quick SDN
test” on page 209.

Note: The SDN for Enterprise Networking is, by default, the same default used
by AMIS Networking.

If Enterprise Networking and AMIS Networking share an SDN with another
service, send the message to that SDN when you enter the system access
number.

The SDN test consists of sending a message to a mailbox at your local site. You
address the message asiif it is being sent to an Open AMIS site. You enter the
system access number in dialable format. For thistest, the system access number
consists of the following:

» theaccess code required to dial out of the system
= Yyour local site’'s number, including the exchange code and SDN

To perform the SDN test
1 Login to CallPilot.

2  Press 75 to compose a message.
3 Enter the following:

= the AMIS compose prefix

= the system access number

= #to indicate the end of the system access number
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4  Enter the local mailbox number on which you are currently logged, followed
by #.

Result: The system responds with the following message: Open net wor k
user <nmil box nunmber> at <system access nunber >,

Press # again to indicate the end of the list of recipients.
Press 5 to record a message.
Record the message.

Press # to stop the recording.

© 00 ~N o o

Tag the message as urgent.
10 Press 79 to send the message.

Result: The system responds with the following message: Message
sent.

11 Log off.

Evaluating test results

The message is sent according to the scheduling parameters for urgent messages.
Thetest is successful if you receive the message you recorded.

Thetest is not successful if you receive a non-delivery notification message.

If the test is not successful

If the SDN test is not successful, check the Enterprise Networking SDN in the
SDN Table. Review the SDN setup requirements and make any necessary
adjustments.

See also

For an overview of setting up SDNs, consult the Advanced Administration
Guide.

For a detailed discussion of setting up SDNs for Enterprise Networking, consult
“Adding and configuring SDNS’ on page 112.

What's next?

After you successfully complete the SDN test, perform the loopback test.
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Quick SDN test

Introduction

The quick SDN test verifiesthat thelocal system can receive messages. This test
confirms that Enterprise Networking is correctly configured in the SDN Table.

The quick SDN test does not require the participation of aremote network
administrator.

Thelocal SDN test can be substituted for the quick SDN test. See “Local SDN
test” on page 207.

To perform the quick SDN test

1 Loginto CallPilot.

2 From your local telephone, enter the local SDN for Enterprise Networking.
3 Listen for the system to answer the call.
4

Repeat these steps for every SDN used by Enterprise Networking.

Evaluating test results

The quick SDN test is successful if the system answers and waits for a C-tone.
The system times out after approximately 20 seconds.

Thetest is not successful if any prompts are heard.

If the test is not successful

If the quick SDN test is not successful, check the Enterprise Networking SDNs
in the SDN Table. Review the SDN setup requirements and make any necessary
adjustments.

For detailed information on setting up SDNs, consult the relevant section in the
Advanced Administration Guide.

What’s next?
After you successfully complete the SDN test, perform the loopback test.
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Loopback test

Introduction

A loopback test confirms that a message can be sent from aloca site to aremote
site, and returned to the local site.

You should perform this test after you add each remote site to the local database.

To perform the loopback test, compose and send a message to aloopback
mailbox at aremote site. A loopback mailbox automatically returns amessage to
the originator.

Before you begin

Before you perform the loopback test, ensure that aloopback mailbox exists on
each remote site tested.

Loopback mailbox

A loopback mailbox isamailbox that is set up on every site in the messaging
network. The only purpose of aloopback mailbox isto return a confirmation of
receipt.

Get the loopback mailbox number from the network administrator of each
remote site with which you are performing the loopback test.

To perform the loopback test

Log in to CallPilot.

Press 75 to compose a message.

Enter the network address of the remote site.

Enter the loopback mailbox number of the remote site.
Press 5 to record a message.

Record the message, and press # to stop recording.

Tag the message as urgent.

o N o o b~ W N P

Press 79 to send the message.
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9  Wait for your Message Waiting Indicator light to activate. This light indicates
that the message was successfully returned to you.

Note: Activation may take several minutes.
10 Login and listen to the message.

11 Log out of the system.

Evaluating test results
Thetest is successful if you hear the message that you recorded.

The message is not successful if you receive a non-delivery notification
message.

If the test is not successful
If the test is not successful, do the following:

= Check with the remote network administrator and confirm the loopback
mailbox number.
= Perform thetest again to ensure that the message was addressed correctly.
= Consult the operational measurement reports to determine the following:
« Arethe connection DNs correct?
« Isthe remote site operational ?
« Do the message transfer protocols match?

What's next?

After you successfully complete the AMIS loopback test, perform the end-to-
end test.
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End-to-end test

Introduction

An end-to-end test verifies that users at aremote site can receive messages from
users at the local site.

To perform the end-to-end test, send a message to a mailbox at a remote site.
Send the test message to the mailbox of the remote network administrator and
reguest a confirmation.

Before you begin

You must coordinate with the remote network administrator of each site with
which you wish to perform aloopback test. Each remote administrator must
listen to the message you have sent before returning an acknowledgment to you.

To perform the end-to-end test

Log in to a mailbox.

Press 75 to compose a message.

Enter the mailbox address for a mailbox at a remote site.
Press #.

Press # again.

Press 5 to record a message.

Record the message, and then press # to stop the recording.

Tag the message as urgent.

© 00 N o 0o b~ W N PP

Press 79 to send the message.

=
o

Log out of the system and hang up.

AR
[N

Ask the remote administrator to log in to the mailbox and listen to the
message.

12 Wait for an acknowledgment to be returned to you.

13 Log in to the mailbox and listen to the acknowledgment.
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Evaluating test results

Thetest is successful if the message is successfully delivered to the remote
system.

Thetest is not successful if anon-delivery notification (NDN) is received, which
indicates that the message was not delivered.

Confirming successful delivery

Even if you do not receive an NDN, you may want to confirm that the message
was successfully delivered.

To confirm the delivery, either

= log on to the remote site and read the message, or
= ask the administrator at the remote site to log on and read the message

If the test is not successful

If the end-to-end test fails or produces unexpected results, check the following:
=  Wasthe message correctly addressed?

= Doesthe mailbox on the remote system exist?

= Doesthe NDN provide any indication of the problem?

If you receive an NDN, listen to the message to determine why the test
message was hot delivered.

IF the NDN states THEN

it took too many attemptsto send the cause may be
the message = incorrect message transfer protocol.
= incorrect siteID.
= incorrect connection DN.
= incorrect passwords.
= theremote siteis disabled.
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IF the NDN states THEN

the address was incorrect the message was delivered to theremote site

but could not be delivered. The cause may
be

= the mailbox does not exist.
= the wrong mailbox number was used.

» the Receive Composed M essages box on
the Class of Services screen is set to No.

= thedisk at the remote siteisfull.

= Do theaarms and events reports provide details of the possible causes?

Since all previous tests have been successfully completed, the remote site
probably caused the test to fail.

Examples of remote site causes include the following:

What’s next?

Incorrect password pairs were assigned between sites.
Channels were not available.

Addresses were incorrect.

Connection DNs do not terminate on the networking DN.
A remote site that is not yet operational was specified.

The end-to-end test isthefinal test in the Enterprise Networking test suite. When
you successfully complete the loopback test, perform a backup of your
configuration.
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Backing up Enterprise Networking

Introduction

When all tests of the system are successfully completed and Enterprise
Networking is working properly, perform a backup.

The backup ensures that the configuration is not lost due to system failure.

Backup schedule
Perform amanual backup asthe final step in the AMIS Networking installation.

Note: You must perform a manual backup even if the system is configured to
perform an automatic backup.

In the unlikely event that the system experiences a disk failure before the
automatic backup takes place, the networking configuration could be lost.

Whenever you modify Enterprise Networking information during regular
maintenance, perform a backup.

System backup components
A system backup consists of two parts.

= switch backup
= CdlPilot backup

Switch backup

For detailed instructions on how to perform a switch backup, consult your
switch documentation.

CallPilot backup

You can perform afull or partial backup of your CallPilot system. For detailed
instructions on how to perform a CallPilot backup, consult the Advanced
Administration Guide.
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Maintaining Enterprise Networking

After you compl ete the Enterprise Networking implementation, you only need to
perform regular maintenance.

This chapter describes maintenance procedures that must be performed
regularly. The chapter also describes maintenance procedures that you perform
only when required.

In this chapter

About maintaining Enterprise Networking 219
Regularly scheduled maintenance tasks 225
As-required maintenance tasks 227
Maintaining remote users 249
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About maintaining Enterprise Networking

In this section

Overview 220
Maintain a network history 222
Printing configuration information 223
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Overview

Introduction

After you successfully install and test Enterprise Networking, you need to
perform two types of maintenance tasks:

= regularly scheduled
= asrequired

Regularly scheduled tasks
Regularly scheduled tasks include
= checking the network status
= reviewing Operational Measurement (OM) reports

Although you can perform regularly scheduled tasks at any time, perform these
tasks at least once a week. Since these tasks do not interfere with the operation
of the Enterprise network, you can schedule them at a convenient time during a
regular workday.

If you monitor the performance of your messaging network, you avoid future
problems. Careful monitoring shows bottlenecksin the system and indicates
how the system can be improved.

Monitoring can aso help you to plan and forecast future messaging network
requirements.

As-required tasks
Perform as-required tasks as needs arise. As-required tasks include
= modifying networking parameters
» disabling and enabling Enterprise Networking
= modificationsto the Enterprise Networking configuration
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When to perform as-required tasks
Since as-required tasks may affect the entire system, perform these tasks when
the system is not in heavy use.

Maodifications to the configuration may be necessary for the following reasons:

= New legal delivery times are announced for computer-generated calls.

=  The system performance suggests that adjustments to the parameters are
required.

= The system access number is changed.

ATTENTION! Because as-required tasks may affect the performance of

the entire system, schedule them for off-peak hours.

Perform a backup following maintenance

Perform abackup of the system whenever you modify the network parameters as
part of your maintenance.
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Maintain a network history

Introduction
Keep detailed records of a network’s history. These records can

= indicate significant performance or equipment issues that real-time
monitoring may not detect

= provide a background for comparing the current information
= provide information needed during support calls

Information to record
A network history should contain the following types of information;

= installation dates and descriptions

= contact information for all key personnel involved in the system installation
and configuration

» details of software installed on the messaging server, including versions
= installation process and results, including tests

= diagrams of theinitia and subsequent network configurations

= any problems encountered and their solutions

= hardware and software changes

= changesto the messaging network layout

Where to keep the records

Make the records of your messaging network easy to access and easy to read.
Graphics, including hand-drawn sketches, can be very useful.

Keep recordsin alog or online. Note, however, that online records online cannot
be accessed if the system fails.

See also

For a detailed description of messaging network histories, consult the
Networking Planning Guide.
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Printing configuration information

Introduction

Printouts of the system configuration are often included in a network history.
You can print all configuration information contained in your local network
database.

To print configuration information, you must open the relevant Properties dialog
box. For example, to print an item in the Messaging Network Configuration tree
view, you must open the Properties dialog box of the item.

If aProperties dialog box consists of more than one tab, the contents of all tabs
are printed.

Note: You cannot print the tree view of the messaging network contained in the
Messaging Network Configuration dialog box.

When to print configuration information

Although configuration information is always available in the most recent
backup of your network database, you may find it convenient to make printouts
aswell.

Printouts of the configuration information are especially useful in the following
situations:

= You must fax information to a remote network administrator.
= You are keeping a hetwork history.

= You are planning to change a configuration or delete an item from the
Messaging Network Configuration tree view, and you want a hard copy of
the original configuration.

Enterprise Networking Implementation and Administration Guide 223



Maintaining Enterprise Networking Standard 1.0

Getting there Nortel SMI > Meridian Application Server > CallPilot >
Networking > Message Delivery Configuration or Messaging
Network Configuration

To print the configuration information
1 Open the dialog box that you want to print.
2 With the dialog box open, click the Print button.

Result: The contents of the dialog box print. The printout includes the
contents of all tabs.
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Regularly scheduled maintenance tasks

In this section

Reviewing OM reports and alerts 226
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Reviewing OM reports and alerts

Introduction

Operational Measurement (OM) reports show how much of the Product Name
Long system is being used by Enterprise Networking.

Three OM reports provide Enterprise Networking information:

This OM report provides

Open Networking Activity information about open networking activity
over aspecified timeinterval.

Network Usage Bill-back information to bill back the cost of users'
networking activities.

Failed Networking Sessions notification that the number of networking
aert failures equals or exceeds the total number of
networking attempts.

Although you can review OM reports at any time, you should review them at
least weekly.

Access to OM reports is restricted

The generation of OM reportsis arestricted activity that is determined by access
level. If you do not have the necessary access, you must ask your system
administrator to generate the reports.

The OM report request screens let you choose the reports that you want to view
and print. For many reports, you can also customize the displayed results so that
you receive the information in aformat that best suits your needs.

See also

For additional information on OM reports, including how to interpret them,
consult the Reporter Guide.
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As-required maintenance tasks

In this section

Overview 228
Modifying the Enterprise Networking configuration 230
Disabling and enabling Enterprise Networking 232
Modifying message delivery parameters 235
Modifying the channel resource allocation 237
Add, modify, or delete remote sites 239
Locating an item in the tree view 241
Modify a remote site configuration 242
Deleting items in the tree view 245
Modifying dialing plan information 248
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Overview

Introduction
You may need to modify the Enterprise Networking configuration, including

whether the system can send or receive Enterprise messages

the time periods when outgoing messages are alowed to be sent during
business and nonbusiness days

the minimum and maximum port allocation for Enterprise Networking
how many messages to transmit in each Enterprise Networking session
the scheduling parameters

Scheduling parameters
The scheduling parameters that may be modified are

economy message send time

stale times for economy, standard, and urgent messages
batch threshold

delivery days and times

Identifying required modifications
Changes to the Enterprise Networking configuration may be required if

message delivery scheduling is not performing as anticipated

there are changes to the long-distance charge period or to delivery days and
times
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Example 1

When you originally configured the system, you set the economy delivery start
timeto 8:00 p.m. and the stale time to 4 hours. Users find that many of their
messages are going stale and are being returned with non-delivery notifications.

A coordination problem exists between the two scheduling parameters. If you
compose an economy message in the morning, it may go stale before the
delivery time begins. Therefore, you must reconfigure the staletime to 20 hours,
for example. This reconfiguration ensures that messages can be composed
throughout the business day and will not go stale before the delivery begins.

Example 2

When you originally configured Enterprise Networking, the lower rates for long
distance cameinto effect at 11:00 p.m. Therefore, you set the economy delivery
start time to 11:00 p.m.

However, the telephone company has announced new periods for lower long-
distancetoll rates. Lower rates now begin at 8:00 p.m. Therefore, you change the
economy delivery start timeto 8:00 p.m.
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Modifying the Enterprise Networking
configuration

Introduction

If you need to modify the Enterprise Networking configuration, follow these
general guidelines.

Risk of loss of functionality
Changes to the networking configuration should be done

during hours when users are not logged on. Making changes
to the configuration while users are logged on may result in
loss of messaging functionality.

CAUTION!

Getting there Nortel SMI > Meridian Application Server > CallPilot >
Networking > Message Delivery Configuration > Enterprise tab

To modify the Enterprise Networking configuration

1 Review Chapter 5, “Configuring CallPilot for Enterprise Networking”, to
ensure that you understand the impact of the changes.

2 Enter all required modifications on the Enterprise tab.
3  Click Save.

Result: The system validates the modifications and, if they are valid, puts
the modifications into operation immediately.
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Announce some modifications

Most of the modifications that you make to the Enterprise Networking
configurations are transparent to your users. Although modifications may affect
the performance of the system, they do not require any new input from users.

However, if you modify the Enterprise site ID, you must announce this changeto
al local users.

If you modify the SAN, you must notify remote callers about this change. Also
remind your local usersto tell users at the open sites about the changes.

Perform a backup

After you modify the configuration of Enterprise Networking, perform abackup
to ensure that these changes are not lost.

Also record the changes in your network history.
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Disabling and enabling Enterprise Networking

Introduction

You may need to disable Enterprise Networking occasionally. When you disable
Enterprise Networking, users cannot compose, send, or receive Enterprise

messages.
You might disable Enterprise Networking to

= prevent system abuse

= temporarily suspend outgoing or incoming messages, or both

Messages sent while system is disabled

When you disable outbound Enterprise Networking, your local users can
continue to compose and send messages. The messages composed by your local
users are held in queue until the option is enabled or the message becomes stale.

When you disable inbound Enterprise Networking, messages from remote
systems are rejected. The remote system that sends the message is informed of
the status, and messages are not accepted.
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Getting there Nortel SMI > Meridian Application Server > CallPilot >
Networking > Message Delivery Configuration > Enterprise tab

To disable and enable Enterprise Networking

1 Do the following:

IF you want to THEN

disable your system from receiving clear the Incoming Enterprise
Enterprise messages Networking check box.
disable your system from sending clear the Outgoing Enterprise
Enterprise messages Networking check box.

enableyour systemto receive Enterprise select the Incoming Enterprise
messages Networking check box.

enable your system to send Enterprise  select the Outgoing Enterprise
messages Networking check box.

2 To save your settings, click Save.

Other ways to disable and enable Enterprise Networking

There are several ways to disable and enable Enterprise Networking. Use the
most appropriate method, depending on the circumstances.

In addition to the Message Delivery Configuration method described above, the
following methods are available:

IF you want to THEN

disable or restrict the sending of  change the Enterprise Restriction/
Enterprise Networking messages Permission List for the user.
to specific or all SANs by a user
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IF you want to

THEN

disable the sending of messages
to any remote site, using any
protocol, by the local server

disable the sending of messages,
using the defined protocal, to a
specific remote site

clear the Send Messagesto all other Servers
option in the Messaging Network
Configuration dialog box for the local
server.

Note: Thisoption isavailable only if
additional networking solutions are
installed on your local system.

clear the Send Messagesto all other Servers
option in the Messaging Network
Configuration dialog box for the remote
server.

Note: Thisoption isavailable only if
additional networking solutions are
installed on your local system.
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Modifying message delivery parameters

Introduction

Message delivery parameters control when and how Enterprise Networking
sends messages. You can modify the following message delivery parameters as
required:

= batch threshold
= Staletimes
= economy delivery start and stop times

Impact of modifications

The message delivery parameters are closely interrelated. M odifications to one
parameter may necessitate changes to others. Therefore, carefully plan
modificationsin advance.

You must test and monitor the performance of the system after you make any
maodifications to ensure that the modifications have the desired effect and no
unplanned side effects.

Note: Before you modify the message delivery parameters, review the previous
discussion of how these parameters are set in Chapter 5, “ Configuring CallPilot
for Enterprise Networking”.
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Getting there Nortel SMI > Meridian Application Server > CallPilot >
Networking > Message Delivery Configuration > Enterprise tab

To modify message delivery parameters

1 Modify the delivery parameters on the tab as required.

2 Review the changes to ensure that there are no conflicts among the
parameters.

3  Click Save.

Perform a backup

After any modification to the configuration, perform a backup to ensure that the
modification is not lost.
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Modifying the channel resource allocation

Introduction

When you implemented Enterprise Networking, you set the minimum and
maximum channel resource alocation for both the inbound and the outbound
Enterprise Networking SDNs. The channel resources determine how efficiently
services are accessed.

Balance channel resources

You must carefully balance channels for each service when you allocate channel
resources. You must allocate enough channelsto ensure that users can accessthe
service. However, you must not overallocate channels so that users are unable to
access other services.

Determine if modifications are necessary

To determine if modifications to the channel resource allocation are necessary,
monitor service usage. After Enterprise Networking isin service for a period of
time, use the Reporter feature to determine how services are being used.

Reporter provides the following statistics:

= the number of calls queued for a service

= theaveragewait timefor queued calls

= the maximum wait time for queued calls

= thenumber of callers who abandoned the queue

If you are dissatisfied with the performance of AMIS Networking after
analyzing these statistics, modify the resource allocation. However, remember
that modifications to the resource allocation for one service may affect the
performance of other services.
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Getting there Nortel SMI > Meridian Application Server > System Configuration

> Service Administration > Service Directory Number > Service
Directory Number Table

To modify an SDN

1
2

In the SDN Table, select the SDN you want to modify.

On the File menu, select Properties.

Result: The Edit Service Directory Number properties dialog box appears.
Make the necessary modifications.

Click Save.
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Add, modify, or delete remote sites

Introduction

Asyour messaging network grows and changes, you may need to add or delete a
remote site, or to modify the configuration of an existing remote site.

It isvery important that all network administrators keep the information in their
network database up-to-date.

Before you begin

Before you add, modify, or delete aremote site, create a printout of all
configuration information that will be affected.

Add aremote site

When you add a site to the messaging network, all sites add the new site to their
Messaging Network Configuration tree view. The remote administrator must
provide the information necessary to add and configure aremote site.

Modify a remote site

You can modify the configurations of both the messaging server and the switch
locations as needs change. For example, if aremote site upgradesits system, you
must modify its configuration information in your network database.

It isimportant that the information in your network database reflect the actual
configuration of the remote site. The remote network administrator must inform
you of al necessary changes.
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Delete a remote site

When you remove a site from the messaging network, the site must be deleted
from the Messaging Network Configuration tree view.

Impact on network database

Your network database reflects any additions, modifications, or deletionsto
remote sites. For this reason, you should perform the Enterprise Networking test
suite again, as well as a backup.
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Locating an item in the tree view

Introduction

It can be difficult to locate a particular remote site, messaging server, or switch
location in the Messaging Network Configuration tree view in avery large
messaging network.

There are two ways to locate an item in alarge messaging network:

= Scroll through the alphabetized list.
» UsetheFind feature.

Getting there Nortel SMI > Meridian Application Server > CallPilot >
Networking > Messaging Network Configuration

To locate an item using Find

1  On the File menu, select Find.
Result: The Find dialog box appears.
2 Enter the name of the item to be located, and press the Find button.

Result: The located item is highlighted in the Messaging Network
Configuration tree view.
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Modify a remote site configuration

Introduction
Modify the configuration of a remote site as required.

To modify aremote site, you must open the Messaging Network Configuration
tree view and select the remote messaging server or switch location that you
wish to modify.

Further information
Make modifications to the configuration on the Properties dialog box where the

[
f

nitial configuration was made. To review the settings, consult the instructions
or theinitial configuration.

To review the settings on this

Properties dialog box consult

Remote Messaging Server “Configuring aremote messaging server”
on page 166.

Remote Prime Switch Location “Configuring aremote prime switch

location” on page 175.

Remote Satellite Switch Location  “Configuring a remote satellite switch
location” on page 187.

Impact of modifications

When you modify the configuration of a remote system, networking service
between the remote site and your local site may be affected. M odificationsto the

f

ollowing settings are especially important:
siteIDs
connection DN
dialing plans
message transfer protocol
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Enterprise Site IDs

Do not change the remote site ID unless the administrator at the remote site
notifies you of achangein that ID, or if the ID isincorrect.

If you change the site ID to an invalid number by mistake, the system is unable
to send or receive messages from the site.

Connection DN
Do not change the connection DN to a remote site unless

= theadministrator at the remote site notifies you that the DN in the SDN
Tableis changed, or

= Yyou are changing the message transfer protocol

Dialing plans
Do not change the dialing plan unless the dialing plan on the switch is changed.

Message transfer protocol

Do not change the message transfer protocol unless all network administrators
who use the protocol to exchange messages with your site agree to the change.
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Getting there Nortel SMI > Meridian Application Server > CallPilot >
Networking > Messaging Network Configuration

To modify the configuration of a remote site

1 Inthe Messaging Network Configuration tree view, select the remote
messaging server or server that you want to modify.

2 On the File Menu, select Open.
Result: The Properties dialog box for the selected item opens.
Make all required modifications.

4  Click Save.

Result: The modifications are validated and saved to the network
database.

5 Repeat steps 1-4 for all items in the tree view that must be modified.

After modifications are complete

You must test modifications to the configuration of aremote site. Compl ete the
test suite to ensure that the modifications work properly.

When you are satisfied that your system isworking properly, perform a backup.
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Deleting items in the tree view

Introduction
The Messaging Network Configuration tree view contains all sitesin your
messaging network with which the local site exchanges messages.

A site always consists of a messaging server and a prime switch location. A site
may also include satellite switch locations.

Sites and satellite switch locations are del eted from the Messaging Network
Configuration tree view.

Note: You cannot delete the local site. You can delete local satellite switch
locations.

ATTENTION! When an item is deleted from the Messaging

Network Configuration tree view, it is permanently
removed from the local network database. The
information cannot be recovered.For this reason, it
is strongly recommended that you print out the
complete configuration of all itemsto be deleted. If
an item is accidentally deleted, you can use the
printed information to add the item again.

Multi-administrator environments

If several administrators maintain your local network database, ensure that your
view of the Messaging Network Configuration tree view is up-to-date. The
Messaging Network Configuration tree view is updated when it isinitialy
opened. An open tree view is not updated when another administrator makes
changes.

To check the status of the view

To seeif another administrator has made changes to the Messaging Network
Configuration tree view, on the View menu, click Refresh.
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Getting there Nortel SMI > Meridian Application Server > CallPilot >
Networking > Messaging Network Configuration

To delete a remote site
1  Print the configuration details of the site that you want to delete.

2 Open the folder of the remote site to see the messaging server, prime
switch location, and any satellite switch locations.

In a multi-administrator environment, on the View menu, click Refresh.
4  Highlight the messaging server of the site that you want to delete.
Select File > Delete.

Result: A confirmation box appears asking if you really want to delete the
site from your local network database.

6  To delete the site, click Yes.

Tip: You can also delete a highlighted remote site by clicking the Delete
button.

Deleting several remote sites at once

If you must delete several remote sites from thelocal network database, you may
find it more efficient to delete all the sites at once.

To delete several remote sites at once
1  Print the configuration details of all the sites that you want to delete.
2 Inthe tree view, highlight all the remote sites that you want to delete.

Tip: To select more than one item in the tree view, press Ctrl and right-click
the mouse.

3 Select File > Delete.

Result: A confirmation message appears. To delete the sites, click Yes. To
keep the sites, click No.
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Deleting a satellite switch location

If there are changesto an NM S site, you can delete one or more satellite switch
locations from the local site or from any remote sites.

If you remove a satellite switch location from an NMS site, you must also
remove it from the local network database.

To delete a satellite switch location

1

2
3
4

Print the configuration details of the satellite switch location.

In a multi-administrator environment, on the View menu, click Refresh.

Highlight the satellite switch location that you want to delete.

On the File menu, click Delete.

Result: A confirmation message appears. To delete the sites, click Yes. To

keep the sites, click No.

Enterprise Networking Implementation and Administration Guide

247



Maintaining Enterprise Networking Standard 1.0

Modifying dialing plan information

Introduction
After you establish a dialing plan, you rarely modify it. Modificationsto a
dialing plan affect users and may require considerable relearning of the system.

However, if modifications are necessary, they are usually guided by changes
made by the switch technician. These changes can be local or remote.

Switch changes

If any changes to the dialing plan are made on a switch, the network databases
of the sitesin the messaging network must reflect these changes. If changes are
made locally, ensure that all remote sites are notified.

To modify the dialing plan information

If you need to modify the dialing plan, follow the general instructions to modify
the local and remote sites.

Modifying CDP steering codes

Modifications to the CDP steering codes are more complicated. For a detailed
review of how to plan for and implement changes, consult Chapter 4, “Dialing
plans and networking,” in the Networking Planning Guide.

Initiating and responding passwords

If you modify the initiating or responding password for aremote site in your
network database, you must ensure that the same change is made in the network
database of the remote site.

The initiating and responding passwords in both databases must match to ensure
proper communication between sites.

See also

For areview of how initiating and responding passwords must be set up, consult
“Initiating and responding passwords’ on page 72.
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Maintaining remote users

In this section

Overview 250
Adding remote users with User Administration 251
Finding remote users 254
Printing a list of remote users 258
Modifying records of remote users 259
Manually deleting remote voice users 260
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Overview

Introduction

After you have added remote users, you will have to perform regular
maintenance activities to keep your system working optimally.

Maintenance activities

Common maintenance activities include the following:

Add remote users.
Find remote users.
List remote users.
Print remote users.
Modify remote users.
Delete remote users.
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Adding remote users with User Administration

User Administration

With User Administration, you can manually add temporary and permanent
remote users. Remote users are added one at atime.

User Administration requires you to enter detailed information for each remote
user, including

= genera information
= settingsinformation

General information

Setting

Personal identification information is required for every remote user. This
information includes

= last name, first name, and initial

= Ccomments

» titleand department

The personal identification information should be as compl ete as possible.

Check the spelling of the remote user’s name. The namethat you enter isused by
Name Dialing and Name Addressing.

information

Setting information includes the following:

= mailbox number

= primary, secondary, and tertiary DNs

= Whether apersonal verification isrecorded

=  whether the remote user can be name-dialed by external callers
= Whether the remote user has temporary status
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Mailbox number

The remote user’s mailbox number must be in network format and must include
the network prefix or steering code required to address to the mailbox. For
example, if the remote user’s mailbox number is 4433 and the ESN prefix is
6233, enter 62334433.

DNs

A remote user can have up to three extension DNs. This means that a caller can
dial any one of these numbers and reach the remote user.

The DNs must be in network format and must include the network prefix or
steering code required to call the remote user.

Personal verification recorded

When aremote user is added with User Administration, the remote user’s own
voice cannot be used for the personal verification. The system administrator
must record a personal verification on behalf of the remote user.

When a personal verification has been recorded for the remote user, the Personal
verification recorded box says Yes.

When a personal verification has not been recorded for the remote user, the
Personal verification recorded box says No. Instead of a personal verification,
callers hear the mailbox number and the site spoken name, if one exists.

Name-dialable by external callers

The remote user can be name-dialed by external callers who are not part of your
network.

Temporary user

The remote user can either be atemporary user or aremote user. This status can
be changed as required.
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Last access time

Monitor the activity of remote usersto ensure that the system is used optimally.
For example, if a permanent remote user has not used the system for ayear, it
may be best to change the user’s status from permanent to temporary.

When you add a remote user to your database, the last accesstimeis
automatically filled in. The last accesstime is automatically updated whenever
the remote user uses the system.

Adding a remote user manually
You can add aremote system to your network database manually.

Getting there Nortel SMI > Meridian Application Server > CallPilot > User
Administration > User Creation Template

To add a remote user with User Administration
1 Inthe User Creation Template list, select Remote User Template.

Result: The New User Template appears.

2  Ensure the User Properties and Mailbox Capabilities check boxes are
selected.

On the General tab, complete all required information.
4 Onthe Settings tab, complete all required information.

Click Save.
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Finding remote users

Introduction

CallPilot enables you to find all users on your local system, including remote
users.

Finding aremote user is often your first step in a maintenance activity.

Methods available
There are two ways to find aremote user or a group of remote users.

IF THEN

you know the remote user’s mailbox use the Remote User dialog box.
number

you do not know theremote user’'s  usethe Find Remote User dialog box.
mailbox number

To find a remote user whose mailbox number is known

1  From User Administration, select Remote User.
2  Select the Remote User item and press Enter.
Result: You are prompted to enter a mailbox number.

3 Enter the remote user’s mailbox number, including the access code and
network prefix, and press Return.

Result: The information for the remote user appears.

Finding a remote user whose mailbox number is not known

If you do not know aremote user’s mailbox number, you can find the user by
performing a search of the remote user database. You can use this method to find
asingle remote user or a group of remote users who share some characteristics.
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You can use various search criteriato help narrow your search. The search
criteriaare what you know about the remote user, or group of remote users.
CallPilot searches your database and returns alist of all users who meet the
specified criteria.

Search criteria

You can perform a search based on the following fields:
= Mailbox number

= Lastname

= First name

= Department

= Title

Wildcards in search criteria
When you are unsure of acharacter or string of charactersin your search criteria,
you can use wildcards. Wildcards represent the unknown characters.

For example, if you do not know if aremote user’s last name is spelled Johnski
or Jonski, you can enter Jo+nski. Your search will locate al remote users whose
last name begins with Jo and ends with nski.

There are two valid wildcards;

= Theunderscore () replaces a single character.
= Theplussign (+) replaces astring of characters.

Wildcards can be used in the following fields:
= Mailbox number

= Lastname

= First name

= Department

= Title
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Examples
The following examples illustrate how the Find function can be used:
= You need to find Robert Jones in the Technology Department.

= You need to find an employee whose last nameis Mordavia, but you do not
know if she uses the first name Elizabeth, Beth, or Liz.

= You must locate all users who have not yet recorded a personal verification.

= Youmust find all usersin the New Productions department so that they can
be reassigned to the new Research and Devel opment department.

Results: When the remote users are found, they are presented in alist. The
following information is provided for each found remote user, if available:

= last name
» first name
= title

= department
= comments

Uses of the results list

The list of remote usersthat is displayed as a result of a search has various uses.

View or modify a found remote user

You can view the information contained in the database for any remote user in
thelist.

To view the information, select the remote user whose information you want to
view, and press Enter. The remote user’s User Administration screen appears.

You can modify the information about the remote user, including recording a
personal verification for a remote user or changing the status of aremote user
between temporary and permanent.

To modify the information, make all required changes to the information and
press Enter. The database is updated.
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Delete a remote user
Delete al remote users who are not required.

See also

For more information about working with users, consult the Basic
Administration Guide.
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Printing a list of remote users

Introduction

You can print alist of all the remote usersin your network database. Thislist
provides detailed information about the remote users and their activities. Review
thislist as part of the regular maintenance of remote usersin your network
database.

Getting there Nortel SMI > Meridian Application Server > User Administration >

Users

To print the list of remote users

1

a b~ W N

In the Users dialog box, on the File menu, click Open Search.
Result: The Search Users dialog box opens.

In the Condition box, select User Type.

In the Operator box, select “Is.”

In the Value box, select Temporary or Permanent Remote Users.
Click Search.

Result: A list of all remote user appears.

On the File menu, select Print.
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Modifying records of remote users

Introduction

You can modify the information about remote userswhen required. M odification
of remote user records isimportant for keeping records up-to-date.

Example

Hanna M oosis apermanent remote user at your site. Recently she was promoted
and moved from the sales department to a senior management positionin
marketing. She received a new mailbox number as well.

You modify the information contained in your database to reflect these changes.
In addition to changing the department and mailbox number fields, you change
Hanna's status from temporary to permanent.

Before you begin

To modify any information about a remote user, first find the remote user’s
records.

Getting there Nortel SMI > Meridian Application Server > User Administration >
Users

To modify a remote user

1 Find the record of the remote user that you want to modify.

Note: For procedures on finding a remote user, consult “Finding remote
users” on page 254.

Open the record of the remote user.
Make any necessary changes.
4  Click Save.
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Manually deleting remote voice users

Introduction
You can manually delete any remote user, both temporary and permanent.

Example

Two remote users, Pedro Afonso and Yang Wang, recently left your company.
You would like to remove them from your database. Pedro is a permanent
remote user. If you do not manually remove hisrecord, it will remain in your
database indefinitely. Yang is atemporary remote user. If you do not manually
remove his record, it will remain in the system until a nightly audit eventually
removes it.

Before you begin
To manually delete aremote user, first find the remote user’s records.

To manually delete a remote user

1 Find the record of the remote user that you want to delete.

Note: For procedures on finding a remote user, consult “Finding remote
users” on page 254.

2 Open the record of the remote user and make sure that it is the correct
remote user.

To delete the record, click Remove.
4  Click Save.
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Troubleshooting Enterprise
Networking

Although testing and regular maintenance procedures ensure that Enterprise
Networking is operating properly, the system may experience occasional
problems. This chapter describes how to diagnose and correct these problems.

In this chapter

About troubleshooting Enterprise Networking 263

Determining if problems are switch-related 269
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About troubleshooting Enterprise
Networking

In this section

Overview 264
Determining if Enterprise Networking is disabled 266
Reviewing Alarm and Event reports 267
Reviewing Operational Measurement reports 268
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Overview

Introduction

If you are experiencing problems with Enterprise Networking, this chapter will
help you to identify and solve these problems.

Common causes of Enterprise Networking problems include the following:

=  Enterprise Networking is disabled.

= Thestatus of aremote site prevents it from receiving messages from the
local site.

= Networking configuration isincorrect or incomplete.
= Theswitch is configured incorrectly.
= There are hardware problems.

Identifying the source of the problem

To identify the source of the problem, first determineif Enterprise Networking is
disabled.

If Enterprise Networking is properly enabled, then review the following:

= appropriate Alarm and Event reports
= network status
= Operational Measurement (OM) reports

Configuration errors

Configuration errors may include the following:

= incorrect connection DNs

=  message transfer protocols that do not match between the remote and local
sites

= incorrect dialing plan information, including ESN prefixes and CDP
steering codes

= scheduling parameters that need to be modified
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Site status errors
A site can be either intentionally disabled or put into error status.

A remote site may be put into error status because of unsuccessful attempts by
the local site to deliver messages to the remote site. Failed message delivery can
happen for the following reasons:

= Theremote site is experiencing hardware or software problems.
= There are site configuration errors.

Switch-related problems

If you are unable to identify the problem using CallPFilot, the error may be
switch-related. Perform the call trace test.

Call trace

Call trace helps you to determine if network calls are being blocked for one or
more of the following reasons:

= Digit manipulation is performed incorrectly. Either not enough or too many
digits are inserted or deleted.

= Class of service restrictions are either too stringent or too loose.

» Dialingisincorrect. More digits are required by the trunks or trunk routes.

On the switch, you can perform a call trace on atelephone or on atrunk and a
trunk route.

Hardware problems

If you are unableto locate the problem in the Call Pilot networking configuration
or in the switch, your system may be experiencing hardware problems that are
not related to networking.

Solution
Perform abasic hardware check. Examine all connections.
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Determining if Enterprise Networking is
disabled

Introduction

You must enable Enterprise Networking to receive incoming Enterprise
messages and to deliver outgoing Enterprise messages.

Begin any troubleshooting session by determining if Enterprise Networking is
properly enabled.

There are several methods of disabling and enabling the sending and receiving
of Enterprise Networking messages.

IF THEN check this setting

the system does hot receive  Incoming Enterprise messages enabled.
incoming messages

the system does not deliver  Outgoing Enterprise messages enabl ed.
outgoing messages

To determine if Enterprise Networking is disabled

To determine if Enterprise Networking has been disabled to receive incoming
messages or to send outgoing messages, or both, check the settings on the
Enterprise tab of the Message Delivery Configuration dialog box.

1 From the Message Delivery Configuration dialog box, select the Enterprise
tab.

2 Check the settings of the Outgoing Enterprise networking and Incoming
Enterprise networking check boxes. Ensure that these check boxes are
selected as required for your system.

3  Click Save to exit and save any changes that you made.
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Reviewing Alarm and Event reports

Introduction

Alarm and Event reports track and report system errors and unusual events.
These reports can be viewed on-screen or printed, or both.

Reports related to Enterprise Networking
The following reports are useful for monitoring Enterprise Networking:
= Networking Activity report
= Network Usage Bill-back report
» Failed Networking Sessions aert

See also

For instructions on reviewing and interpreting Alarm and Event reports, consult
the Reporter Guide.
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Reviewing Operational Measurement reports

OM reports

Operational Measurement (OM) reports contain detailed information on how the
system is functioning. When you attempt to locate problems with Enterprise
Networking, review these reports.

When you review the OM reports, consider the following:

This OM result suggests

large number of accesses the holding time may betoo low, or the batch threshold is
too small.

excessive “Failed to Send”  the remote system may be down, or the dialing
messages trandlations are incorrectly configured, or the call
maximum number istoo small.

high number of NDNs users are entering incorrect addresses, or mailboxes do not
exist on the remote system.

networking trafficis an unusual or cyclical event affected the system, or the

excessive number of channels used by Enterprise Networking istoo

small, or the number of channels available to Enterprise
Networking istoo small.

failures the remote system does not support the Enterprise
Networking protocol, or the number of channelsistoo
small.

See also

For detailed instructions on producing, reviewing, and interpreting Operational
M easurement reports, consult the Reporter Guide.
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Determining if problems are switch-
related

In this section

Switch-related problems 270

Call trace test 271

Link diagnostic test 273
269
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Switch-related problems

Enterprise Networking problems and the switch

If you cannot identify the cause of the Enterprise Networking errors using
CdlPilot, the problem may be switch-related.

The following tests identify switch-related problems:

=« caltrace
= link diagnostic
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Call trace test

Purpose

If you cannot identify the Enterprise Networking problem using CallPilot, calls
may be blocked by the switch. The call trace test determines

= if callsare blocked
= why callsare blocked

Why calls are blocked
A network call can be blocked for one or more of the following reasons.

= Digit manipulation is performed incorrectly. Not enough or too many digits
areinserted or deleted.

» Classof servicerestrictions are too stringent or too loose.

» Dialingisincorrect. More digits are required by the trunks or card trunk
routes.

Where a call trace is performed

On the switch, you can perform a call trace on atelephone or on atrunk and
trunk route.

Before you begin
To interpret the results of acall trace test, you need to understand

= how the switch processes calls
= how tointerpret the results of a call trace session

A switch technician should perform the call trace test and interpret the results.
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Theinformation that isrequired to perform the call trace test varies for each type
of switch. However, the following information is usually required:

your customer number
the directory number that will be tested
the type of telephone and key number (for multiline telephones)

the termina number (loop, shelf, card, unit) of the telephone or trunk that
will be tested

the route type and trunk number of the trunk and trunk route that will be
tested

To perform the call trace test
Follow the instructionsin your switch documentation.

How to interpret the results

For guidelines on how to interpret the results of the call trace test, consult your
switch documentation.
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Link diagnostic test

Purpose
If you cannot identify the cause of the networking problem on the CallPilot or by
performing the call trace test, the problem may not be related to networking.

Thelink diagnostic test determinesif the link between the switch and the name
of server isworking.

Before you begin
Thelink diagnostic must be performed by a switch technician.

To perform the link diagnostic test
Follow the instructionsin your switch documentation.
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features, 50

gathering information, 90

implementation in a complex messaging
network, 64

implementation overview, 60

in complex network, 48

information validation, 62

internal controls, 76

local site configuration, 142

maintaining, 220

message, 47

message contents, 66

message handling, 66

modifying an SDN, 238

modifying channel resource alocation, 237

modifying configuration, 228

modifying message delivery parameters,
235, 236

Names Across the Network, 146

parameters, 68

performing backups, 215

phantom DN, 117

preliminary requirements for configuration,
136

protocol used, 47

receiving message text information, 147

relevant OM reports, 226

sending message text information to aremote
site, 170

siteIDs, 48

switch configuration required, 104

switch requirements, 104

switch settingsrequired, 96, 116

switch-related problems, 270

testing, 62

troubleshooting overview, 264

Enterprise Networking protocol, 47
Enterprise Networking test suite, 204
call routing test, 204
end-to-end test, 205
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local SDN test, 204
loopback test, 205
Enterprise Site ID, 48
description, 72, 147
modifying, 243
remote messaging server, 170
Enterprise tab, Message Delivery Configuration
dialog box, 126
ESN
access code, 157
location code, 157
location code overlap, 157
ESN dialing plan, configuration overview, 156
ESN information
remote prime switch location, 181
ESN tab
Prime Switch L ocation Propertiesdial og box,
151
Remote Prime Switch L ocation Properties
dialog box, 175
Remote Satellite Switch Location Properties
dialog box, 187
evaluating gathered information, 96

F

Failed Networking Sessions alert, 226

Fax Call Answering CDN queues, 116

fax channel type, 108

features of Enterprise Networking, 50

Find key, using to locate an item, 241

finding aremote site, 241

finding aremote user, 254

finding problem with Enterprise Networking,
264

FQDN of local SMTP/VPIM server, 142, 147

G

gathering information
checklist, 94
evaluating, 96
for network, 61
from other sites, 97
from switch, 91

purpose, 90

remote switch location checklist, 95

required from switch, 93

switch information, 61

to implement Enterprise Networking, 90

General tab

Prime Switch Location Propertiesdia ogbox,
151

Remote Messaging Server Properties dialog
box, 167

Remote Prime Switch L ocation Properties
dialog box, 176, 187

Remote Switch Location Properties dialog
box, 175

H

hardware problems, 265
header contents, 66
holding time
description, 69
interaction with batch threshold, 128
relationship to staletime, 128
standard messages, 69
urgent messages, 69
holding time for standard messages
default value, 124
holding time for urgent messages
default value, 124
how a message istransferred, 82
how to
add aremote user with User Administration,
253
add and configure a new inbound service
directory number (SDN), 113
check Enterprise Location ID, 196
configure aremote messaging server, 173
configure aremote satellite switch location,
189
configure CDP information, 162
configure CDP information for a remote
prime switch location, 185
configure EnterpriseNetworking parameters,
129
configure ESN information, 158
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configure ESN information for remote prime
switch location, 182

configure loca prime switch location, 155

configure the local messaging server, 148

create aloopback mailbox, 132

delete aremote site, 246

delete a satellite switch location, 247

delete several remote sites, 246

determine if Enterprise Networking is
disabled, 266

disable Enterprise Networking, 233

enable Enterprise Networking, 233

find a remote user with a known mailbox
number, 254

find a remote user with an unknown mailbox
number, 254

import a spoken name, 194

locate an item using Find, 241

modify an SDN, 238

modify dialing plan information, 248

modify message delivery parameters, 236

modify remote site configuration, 244

modify the Enterprise Networking
configuration, 230

open the Prime Switch Location Properties
dialog box, 152

print configuration information, 224

print list of remote users, 258

record a spoken name, 192

share an existing inbound service directory
number (SDN), 114

impact of modifications, 235
implementation
backup, 63
configuring CallPilot, 62
configuring the switch, 61
gather information for network, 61
main steps, 60
order in complex messaging network, 64
overview, 60
parameters set during, 68
preliminary requirements, 60

recommended order in complex messaging
network, 64
testing, 62
validation, 62
implementing Enterprise Networking, NMS
local site, 137
importing a spoken name, 193, 194
inbound service directory number (SDN)
how to add and configure new, 113
how to share existing, 114
services that can share, 112
waysto set up, 112
indicatorsin OM reports, 268
information, gathering to implement Enterprise
Networking, 90
initiating password, 172
description, 72
modifying, 248
installation and configuration guides, 19
Integrated AMIS Networking
implementation, 64

L

last accesstime, 253
link diagnostic test, purpose, 273
local messaging server name, 142
local prime switch location
configuration if NMSlocal site, 150
configuration if other networking solution
implemented, 150
configuration overview, 150
configuration procedure, 155
description, 153
Enterprise Location ID, 153
mailbox prefix, 154
name, 153
Prime Switch L ocation Propertiesdial og box,
151
recording spoken name, 153
local SDN test
evaluating results, 208
procedure, 207
purpose, 204
local server
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configuration if another networking solution
implemented, 143
configuration overview, 144
configuration process, 148
name, 145
server type, 145
local server FQDN, 147
local site configuration, 142
local site name, 142, 145
locating aremote user, 254
locating remote site, 241
location code
ESN, 157
overlap, 157
loopback mailbox
creating, 132
definition, 131
description, 131
requirements, 131
using, 132
loopback test
evaluating results, 211
procedure, 210

M

mailbox addressing follows dialing plan
local prime switch location, 154
remote prime switch location, 178
mailbox prefix
local prime switch location, 154
remote prime switch location, 179
mailbox, loopback, 131
main steps in implementation, 60
maintenance
as-required tasks, 220
backups following, 221
overview, 220
regularly scheduled tasks, 220
Meridian Mail system
remote site, 199
message
body contents, 67
handling scenario, 83
header contents, 66

parts, 47, 66
priorities, 67
transfer process, 82
message body contents, 67
Message Delivery Configuration dialog box,
Enterprise tab, 126
message delivery parameters
modifying configuration, 235
message delivery parameters, configuring, 129
message handling, 78
Message Subject (Text), 52
message transfer protocol, modifying, 243
message transfer, main steps, 77
messages sent while system disabled, 232
messaging network, 136
Messaging Network Configuration tree view
adding sites, 136
messaging network representation
benefits, 99
coordination with other sites, 99
diagram, 98
implementation, 61
overview, 98
security, 99
spreadsheet, 98
migration guides, 18
modifying aremote site, 239
modifying channel resource alocation, 237
modifying configuration of Enterprise
Networking, 228
modifying connection DN, 243
modifying dialing plan, 243, 248
modifying Enterprise Networking
announcing, 231
modifying Enterprise Site ID, 243
modifying message delivery parameters, 235
modifying message transfer protocol, 243
modifying passwords, 248
modifying records of remote users, 259
modifying remote site, 239
impact, 242
impact on network database, 240
preliminary requirement, 239
modifying remote site configuration, 242
MTA (Message Transfer Agent), description, 76
MTA Monitor, description, 76
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multi-administrator environment, deleting items O

from tree view, 245
Multiple Recipients, 51

N

name
local prime switch location, 153
local server, 145
local site, 142
remote prime switch location, 176
remote site, 167
Name Addressing, 50
Names Across the Network, 50, 146
adding remote users, 54
configuration examples, 54
limitations, 57
outgoing sessions, 58
overview, 54
network database, impact of modifying remote
sites, 240
network history
contents, 222
overview, 222
network message service (NMS)
local site, 137
network protocol used with aremote site, 171
network representation, using to add and
configure aremote site, 164
Network Usage Bill-back report, 226
networking
documentation, 20
networking solutions
configuration if implemented, 137
order of implementation, 64
NMS local site, configuring local prime switch
location, 150
NMS site
spoken name imported for, 193
spoken name recorded for, 191
non-CallPilot remote sites, 197
non-CallPilot system
server type, 197
Norstar Voice Mail, remote site, 200

OM reports
importance of reviewing, 226
relevant for Enterprise Networking, 226
restricted access, 226
online guides, 22
online Help, accessing, 22
Open Networking Activity report, 226
outbound service directory number (SDN), 112
overlap
CDP steering code, 161
ESN location code, 157

P

parameters
default values, 68
Enterprise Networking, 68
set during implementation, 68
passwords
description, 72
modifying, 248
passwords for remote site, 172
Personal Distribution Lists, 50
personal verification recorded, remote user, 252
phantom DNs
relationship to service directory number
(SDN), 108
required by Enterprise Networking, 117
waysto create, 118
planning guides, 18
prefix, mailbox, 154
Prime Switch Location Properties dialog box,
151
CDPtab, 151
ESN tab, 151
General tab, 151
opening, 152
SMTP/VPIM tab, 151
printing
configuration information, 223
list of remote users, 258
priorities of messages, 67
Private Tag, 51
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protocol
Enterprise Networking, 47
used with aremote site, 171

Q

quick SDN test
evaluating results, 209
procedure, 209
purpose, 204

R

Received Time Announced, 52
receiving message text information, 147
Recipient’'s Name (Text), 52
recommended order of implementation, 64
recording a spoken name, 192
regularly scheduled maintenance tasks, 220
remote messaging server
configuration if another messaging solution
implemented, 166
configuration overview, 166
connection DN, 172
deleting, 245
Enterprise Site ID, 170
name, 167
network protocol used, 171
sending local user information to, 169
sending message text information, 170
sending messages to aremote site, 168
server FQDN, 170
server types supported, 168

Remote Messaging Server Properties dialog box

Connectionstab, 171
General tab, 167
remote prime switch location
CDP information, 184
configuring ESN information, 182
dialing plan for dialing to thislocation, 178
dialing plan information, 178
Enterprise Location ID, 177
ESN information, 181

mailbox addressing follows dialing plan, 178

mailbox prefix, 179

name, 176
Remote Prime Switch L ocation Properties
dialog box
CDPtab, 175
ESN tab, 175
General tab, 176
SMTP/VPIM tab, 175
tabs, 175
remote satellite switch location
configuration overview, 187
configuring, 189
dialing plan, 188
spoken name recorded, 188
Remote Satellite Switch Location Properties
dialog box
CDPtab, 187
ESN tab, 187
tabs, 187
remote site
adding, 239
adding and configuring, 164
adding, modifying, and deleting, 239
checking configuration, 195
correcting information about, 165
deleting, 245
how to modify configuration, 244
information required to add and configure,
164
locating, 241
Meridian Mail system, 199
modification impact, 242
modifying configuration, 239, 242
non-CallPilot, 197
Norstar Voice Mail system, 200
passwords, 172
using network representation to add and
configure, 164
remote site name, 167
Remote Site Spoken Names, 51
remote sites
if other networking solutions implemented,
137
main steps to add and configure, 164
remote switch location
configuration overview, 175
spoken name, 191, 193
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Remote Switch Location Properties dialog box,
Generd tab, 175
remote switch location, information required,
95
remote user
adding with User Administration, 251
DN, 252
finding, 254
last accesstime, 253
mailbox number, 252
maintenance overview, 250
manually deleting, 260
methods for finding, 254
modifying records of, 259
personal verification recorded, 252
printing list of, 258
status, 252
temporary, 54
time stamps, 58
when added and updated, 57
remote user information, sending, 58
remote users
adding with Names Across the Network, 54
examples of Names Across the Network, 54
Reply All, 51
Reply To, 51
reports for Enterprise Networking, 267
responding password, 172
description, 72
modifying, 248
restricting
message exchange, 145
sending messages to aremote site, 168
reviewing Alarm and Event reports, 267
reviewing OM reports, 226
what to look for, 268

S

satellite switch location, deleting, 245

scheduling backups, 215

Sender’s Department, 53

Sender’s Name (Text), 52

sending local user information to aremote site,
169

sending message text information to aremote
site, 170
sending messages to other sites, 145
Sent Time Announced, 52
server FQDN, 142, 147
remote site, 170
server type
local server, 145
non-CallPilot remote sites, 197
supported for remote messaging server, 168
service directory number (SDN)
adding and configuring new, 113
and DN setting on switch, 108
definition, 106
examples, 109
how to modify, 238
inbound, 106, 112
outbound, 106, 112
relationship to other numbers, 108
sharing existing inbound, 114
Service Directory Number (SDN) Table
description, 106
example, 107
Shared Distribution Lists, 51
site ID number, 48
Site status errors, 265
SMTP/VPIM server FQDN, 142
SMTP/VPIM tab
Prime Switch L ocation Propertiesdial og box,
151
Remote Prime Switch L ocation Properties
dialog box, 175
speech recognition channel type, 108
Speech Recognition Messaging CDN queues,
116
spoken name
for remote switch location, 191, 193
importing, 193, 194
importing for local NMS site, 193
recorded for remote satellite switch location,
188
recording, 192
recording for local NMS site, 191
recording for local prime switch location, 153
recording overview, 191
waysto record, 177
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spreadsheet of messaging network, 98
staletime
description, 70
relationship to holding time, 128
stale timefor economy messages, default value,
124
stale timefor standard messages, default value,
124
stale time for urgent messages, default value,
124
standard message, holding time, 69
standard priority message, 67
steering code for CDP, 161
switch
and directory numbers (DNs), 116
configuration changes, 248
configuring for Enterprise Networking, 61
confirming settings, 92
dialing plan information required, 91
Enterprise Networking requirements, 104
gathering information, 91
how an Enterprise Networking messageis
treated, 104
information required from, 93
information to gather, 61
mandatory reguirements, 96
setting required for Enterprise Networking,
116
switch backup, 215
switch configuration
preliminary requirements, 104
requirements for Enterprise Networking, 104
switch-related problems, 270
cal trace, 265
call tracetest, 271
link diagnostic test, 273

T

technical support, 23
temporary remote user, Names Across the
Network, 54
test suite
call routing test, 204
end-to-end test, 205

local SDN test, 204
purpose, 204
quick SDN test, 204
testsincluded, 204
testing Enterprise Networking, 62
coordination required, 205
ensuring quick results, 205
testing with loopback mailbox, 132
text information in messages, 147
time stamps of remote users, 58
Timed Delivery, 53
tree view, deleting items, 245
troubleshooting
reference documentation, 22
technical support, 23
troubleshooting Enterprise Networking
configuration errors, 264
hardware problems, 265
identifying problem, 264
overview, 264
site status errors, 265
switch-related problems, 265

U

urgent message, 67
holding time, 69
Urgent Tag, 52
User Administration
adding aremote user, 251, 253
user guides, 21
User’s Actua Personal Verification, 51
using aloopback mailbox, 132

V

validation of information, 62

voice channel type, 108

Voice Messaging controlled directory number
queue, 116

VPIM Networking, server FQDN of remotesite,
170
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ways to disable to disable Enterprise
Networking, 233
ways to enable Enterprise Networking, 233
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